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UTCUREERE) hoDEERRTELET, &4
BILRLTEELTETW,

B3/ 8%l %=

TILFELIY— (TR=) £IFIILFT7
23 VEALVILR—) TIEE P EE
HRU., IILFELII—DRENRY VEIFT
WFITPo2avFdA4VILEBLTRET S &
B ST HEN T tR6HE T,

SRTEBE@EHAEZ L% IE. MaintenanceX=a1—

MClock Set(108~R—) #FEALTTime

Zoneb JUHBDREEAZEFETZIENTEE

ER

[T3EE]

o HIFERENMEBINTVEVWNYFU—/CyvTE£DCIN
ERLERINTLEY) ﬁﬁ.ﬁ'@/(‘w’]?w?%ﬂtﬁiﬁ
FEI2L0ELTCREAROBRAEDONLEZSIE. RIS
aﬁ’&lﬂé&*ﬂ@"‘*@ﬁ#ﬁj’*ﬂi?

o HEIFREBEENRRINTVWBIRETIE, COEERET
DRENTETIZFTEREVZUNDBRIFIITES
Th.,

o AEIFHRPREDORELZBROAN/EBFRLE<REF
?%Tc&)k Ju EE_VEE/{E%WE[/‘C \'\353_

BETS

RINFZER

E9J B
REEBOZHIC. ERFTEICEHET.
Project 27 —4% R BEH CEAREEDEREETT

WET,

DCIN19.5 v
4/10

[aStby

an Imager Scan
59.94P FF

Codec Video Format
XAVC-I 3840x2160P

Rec Function

Rec

R

AETIE, BIFTHECHBROEYCHNTES
FCustomE—Ry & RRNFOFI >3 0B
ZHiRRE L. BB TREEYETDLRVWI LA
HASERFDOFEVNNNTESMCine EIE—RY
ZYVEZTERTEET,
Project X5 —4 ZAMShooting Mode
(15R=3) TUIWEBZ £,

[AE]

TILAZa—DProject A = 21— >Base Setting®d
Shooting Mode(84R—) THRETEET.

CustomE—R

REE—RHCUStomE—RDEF &, BEHRIE
EEJNIENTEET,

TILAZ a—DProject A Z a1— >Base Setting
DTarget Display(84R—3) THIWEZ *

9.

o SDR(BT.709) : HDIED#R1E [CHE U fe w2

o HDR(HLG) : KR D AKX DG (CEEL

e

ZOMEFMIIS8R—IEZTBI LTV

Cine EIE—R

REE—RHCne EIE—RDE&EIF, RBFES

BLUHBHNESOR—EHBEEERIRLE

9, ZZTERLEBEAMLUTZOFfICEREL

g HOBHEGY £,

TILAZ a—®DProject A= a1—>Cine El

Setting®Color Gamut(85R—<) THIW

BRET,

e S-Gamut3.Cine/SLog3 : TI9ILIXID
&5 (DCI-P3) ADOFEALPTVERE

e S-Gamut3/SLog3 : VZ—#BE®ITU-R
BT.2020% H/\—¢ 3LV &1

FOMEMIIO0R—IETELETL

[TEE]
e Cine EIE—RTIEHUTOHIKMNGEY T,
o BEFHCER) TRV R
- RITALRNTUR
- gM>
- Yyyyd—
o BREXETTFHVHEEE
- ISORKE /S Y (BAEISOREICEE)
- Paint/LookA=a1—n3i&E(Base Look%R<)
- Scene File(#&3h)
o LUTO##EEZCine EIE—RTODHERTIRETT
(60~R—%),
e Exposure Index
e EZ4H—LUT

2T L ERE

Project X7 —4 XMFrequency/Scan
(15R_=3) TYIWEZFT, REMBICLOT
(F. YIWBREETT2EAHHBENICEL
BLET,

[AE]

TILAZ 2—DProject A Za1— >Rec Format®
Frequency(84R—) THLRETEXY,

[ZEE]

iR - BERCIRTLARBZYIVERZZLETEE
‘A,

AA=I v —FvVE—NR
AA=T L —OEME T A XL REEDER
EETVET,

Project25—4% Z®MImager Scan(15~X—
J) TYIWEBZET,

o FF: I B4 XTHERALET,

e S35: Super35mmyu A/ X THEALET,

[AE]
TILAZa—DProject A Z 21— >Rec Format®Imager
Scan Mode(84~R—%) THLRETEXT,

[TEE]

o SRR -BEHIAA-—Iv—FrUE-—REYVEZS
ZElETEEEA.

o S35MEF EF A TAH—TwME1920X1080 (ZHIFR
ThZET,

d—T w7
Project25—4 ZMCodec(15—) TY]
WEBZFT,

[AE]
TILAZa—DProject A Za— >Rec Format®Codec
(84R—) THLRETTZET,

[ZE=]
R - BERCI-FTyIERYVEBRZCLRITTERA.
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EFA 74— vk

SR ITBIETA T4 —VYNDREETVET,
Project 257 —4 2 ®Video Format(15X—
J) THIWEZ X,

[AE]
TILAZ 2—DProjectA = 21— >Rec Format®Video
Format(84R—2) THLRETTET,

[TEE]

o IR - BFERICETHIA—TyhEYIVEZBZZ L
TEEtHA.

o EFATA—TYRDEREICLDT. SDIOUTH LU
HDMI OUTIRFH S DESEHIRINET,
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AEV—H—FK =ZFEDS

AT, RELCHYE - FF%E. h—RKXOvADCFexpress Type AXE —h—R(BIFE) /=
[ZSDXCAEY—H—R(RITE) ICERFLET, Tl TOFIRER. REANBORE -SiHHLE. §
kON=T3>TPvI(VIRNIITFTPYvTTF—RN) BICEINSOAE)—H—KREFALE,

CFexpress Type AXE—H—KICDWVWT
AHETIE, THEATAT7ICDWVTY (28R—) [CEREHENDY Z—RCFexpress Type AXEY—H—
R&ZEARETL.

B AT A POEEICDOVTIE. BHAT 4 POEIRGBHAZEOA—H—BRE THERIETV,
* KETIECFexpressh—RERBELTVWET,

SDXCAE!)—H—KIEDWVT

AETIE, THEATATICDVT] (28R—2) [CEREHEDSDXCAEY —H—R*&2ZFEALLLE TV,
*ARETIISDH—REREBELTWVWET,
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WREAT A FICDWVT

EN{ERELE A (ZRec Formati>Recording

Yes : BifF = {RaE
No : fREEL7ZW

REICLO>TERYET,

EEFETA—V Vb CFexpress SDXC
Type A

VPG400 Class10 u1 u3 VSC VSC VSC VSC
V10 V30 V60 V90
RAW Out & 4096x% 2160 Normal mode 59.94pP Yes No No No No No No Yes
XAVCI Class300 50P Yes No No No No No No Yes
29.97P Yes No No No No No Yes Yes
25P Yes No No No No No Yes Yes
24P Yes No No No No No Yes Yes
23.98P Yes No No No No No Yes Yes
3840X%2160 Normal mode 59.94pP Yes No No No No No No Yes
Class300 50P Yes No No No No No No Yes
29.97P Yes No No No No No Yes Yes
25P Yes No No No No No Yes Yes
23.98P Yes No No No No No Yes Yes
S&Q(60fpsAT) 59.94P Yes No No No No No No Yes
50P Yes No No No No No No Yes
29.97P Yes No No No No No No Yes
25P Yes No No No No No No Yes
23.98P Yes No No No No No No Yes
S&Q(100fps. 120fps) 59.94p Yes No No No No No No No
50P Yes No No No No No No No
29.97P Yes No No No No No No No
25P Yes No No No No No No No
23.98P Yes No No No No No No No
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ST+ —V vk CFexpress SDXC
Type A

VPG400 Class10 u1 U3 VSC VSC VSC VSC
V10 V30 V60 V90
XAVC-| 4096X%2160 Normal mode 59.94pP Yes No No No No No No Yes
Class300 50P Yes No No No No No No Yes
29.97P Yes No No No No No Yes Yes
25P Yes No No No No No Yes Yes
24P Yes No No No No No Yes Yes
23.98P Yes No No No No No Yes Yes
S&Q(60fpsATF) 59.94P Yes No No No No No No Yes
50P Yes No No No No No No Yes
29.97P Yes No No No No No No Yes
25P Yes No No No No No No Yes
24P Yes No No No No No No Yes
23.98P Yes No No No No No No Yes
3840%2160 Normal mode 59.94pP Yes No No No No No No Yes
Class300 50P Yes No No No No No No Yes
29.97P Yes No No No No No Yes Yes
25P Yes No No No No No Yes Yes
23.98P Yes No No No No No Yes Yes
S&Q(60fpsUT) 59.94P Yes No No No No No No Yes
50P Yes No No No No No No Yes
29.97pP Yes No No No No No No Yes
25P Yes No No No No No No Yes
23.98P Yes No No No No No No Yes
S&Q(100fps. 120fps) 59.94pP Yes No No No No No No No
50P Yes No No No No No No No
29.97P Yes No No No No No No No
25P Yes No No No No No No No
23.98P Yes No No No No No No No
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ST+ —V vk CFexpress SDXC
Type A
VPG400 Class10 u1 U3 VSC VSC VSC VSC
V10 V30 V60 V90
XAVC-| 1920X1080 Normal mode 59.94P Yes No No No No No Yes Yes
Class100 50P Yes No No No No No Yes Yes
29.97P Yes No No Yes No Yes Yes Yes
25P Yes No No Yes No Yes Yes Yes
23.98P Yes No No Yes No Yes Yes Yes
S&Q(60fpsITF) 59.94P Yes No No No No No Yes Yes
50P Yes No No No No No Yes Yes
29.97P Yes No No No No No Yes Yes
25P Yes No No No No No Yes Yes
23.98P Yes No No No No No Yes Yes
S&Q(100fps. 120fps) 59.94pP Yes No No No No No No Yes
50P Yes No No No No No No Yes
29.97P Yes No No No No No No Yes
25P Yes No No No No No No Yes
23.98P Yes No No No No No No Yes
S&Q(150fps. 180fps) 59.94pP Yes No No No No No No No
50P Yes No No No No No No No
29.97P Yes No No No No No No No
25P Yes No No No No No No No
23.98P Yes No No No No No No No
S&Q(200fps. 240fps) 59.94pP Yes No No No No No No No
50P Yes No No No No No No No
29.97P Yes No No No No No No No
25P Yes No No No No No No No
23.98P Yes No No No No No No No
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ST+ —V vk CFexpress SDXC
Type A

VPG400 Class10 u1 U3 VSC VSC VSC VSC
V10 V30 V60 V90
XAVC-L 3840X%2160 Normal mode 59.94P Yes No No Yes No Yes Yes Yes
420 50P Yes No No Yes No Yes Yes Yes
29.97P Yes No No Yes No Yes Yes Yes
25P Yes No No Yes No Yes Yes Yes
23.98P Yes No No Yes No Yes Yes Yes
S&Q(60fpsITF) 59.94P Yes No No Yes No Yes Yes Yes
50P Yes No No Yes No Yes Yes Yes
29.97P Yes No No No No No Yes Yes
25P Yes No No No No No Yes Yes
23.98P Yes No No No No No No Yes
S&Q(100fps. 120fps) 59.94P Yes No No No No No Yes Yes
50P Yes No No No No No Yes Yes
29.97P Yes No No No No No No Yes
25P Yes No No No No No No Yes
23.98P Yes No No No No No No No
1920X1080 Normal mode 59.94pP Yes No No Yes No Yes Yes Yes
HD50 50P Yes No No Yes No Yes Yes Yes
29.97P Yes No No Yes No Yes Yes Yes
25P Yes No No Yes No Yes Yes Yes
23.98P Yes No No Yes No Yes Yes Yes
S&Q(60fpsUATF) 59.94pP Yes Yes Yes Yes Yes Yes Yes Yes
50P Yes Yes Yes Yes Yes Yes Yes Yes
29.97P Yes No No Yes No Yes Yes Yes
25P Yes No No Yes No Yes Yes Yes
23.98P Yes No No Yes No Yes Yes Yes
S&Q(100fps. 120fps) 59.94pP Yes No No Yes No Yes Yes Yes
50P Yes No No Yes No Yes Yes Yes
29.97P Yes No No No No No Yes Yes
25P Yes No No No No No Yes Yes
23.98P Yes No No No No No Yes Yes




32 28 #Efm:AE®U-—DH-—REES

ST+ —V vk CFexpress SDXC
Type A

VPG400 Class10 u1 U3 VSC VSC VSC VSC
V10 V30 V60 V90
XAVC-L 1920X1080 S&Q(150fps. 180fps) 59.94p Yes No No No No No Yes Yes
HD50 50P Yes No No No No No Yes Yes
29.97P Yes No No No No No No Yes
25P Yes No No No No No No Yes
23.98P Yes No No No No No No Yes
S&Q(200fps. 240fps) 59.94pP Yes No No No No No Yes Yes
50P Yes No No No No No Yes Yes
29.97P Yes No No No No No No Yes
25P Yes No No No No No No Yes
23.98P Yes No No No No No No Yes
1920%1080 Normal mode 59.94pP Yes Yes Yes Yes Yes Yes Yes Yes
HD35 50P Yes Yes Yes Yes Yes Yes Yes Yes
29.97P Yes Yes Yes Yes Yes Yes Yes Yes
25P Yes Yes Yes Yes Yes Yes Yes Yes
23.98P Yes Yes Yes Yes Yes Yes Yes Yes
S&Q(60fpsUT) 59.94P Yes Yes Yes Yes Yes Yes Yes Yes
50P Yes Yes Yes Yes Yes Yes Yes Yes
29.97P Yes No No Yes No Yes Yes Yes
25P Yes No No Yes No Yes Yes Yes
23.98P Yes No No Yes No Yes Yes Yes
S&Q(100fps. 120fps) 59.94P Yes No No Yes No Yes Yes Yes
50P Yes No No Yes No Yes Yes Yes
29.97P Yes No No Yes No Yes Yes Yes
25P Yes No No Yes No Yes Yes Yes
23.98P Yes No No No No No Yes Yes
S&Q(150fps. 180fps) 59.94pP Yes No No Yes No Yes Yes Yes
50P Yes No No Yes No Yes Yes Yes
29.97P Yes No No No No No Yes Yes
25P Yes No No No No No Yes Yes
23.98P Yes No No No No No Yes Yes
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;T A—T vk CFexpress SDXC
Type A

VPG400 Class10 U1 u3 VSC VSC VSC VSC
V10 V30 V60 V90
XAVC-L 1920x1080 S&Q(200fps. 240fps) 59.94P Yes No No Yes No Yes Yes Yes
HD35 50P Yes No No Yes No Yes Yes Yes
29.97P Yes No No No No No Yes Yes
25P Yes No No No No No Yes Yes
23.98P Yes No No No No No No Yes
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AEY—hH—FZANS

1 H—kzOvrBOAF«FEEETS,

2 AEU-H-REELAG,
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REPETICT S,

i)
e

|

ficy

FIERSVF(6R—) HR<EITL.
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[TEE]
FUERZVTOFVRADNRSBETRRUTICAS K
WSS, —EEREVIUAE)—h—R2kREEL
TBZET BRITICBDAREMENSYET.

3 AF TEEEDS.

[ZER]

o RoAITTHREICANSG L, AEU—H—RPAEY—
H—Rz20v bk, B&ET—-IDNRIBTZZENBHYET.

e CFexpress Type A/SDAh—RZOw (A) /(B) mAIC
AFAPEBALTCEREZTOIRICE. £55020Y
NZH, EBRTZ 74—y NTHLUTEMEDHRE TN
TVBATATEBALTLREETL,

AE)—H—RZEWHET

H—R2OYREBOAFT A 7EZRIT. AEU—
H—RE@ENERLTERYELET.

[T5EE]

o AEY—H—REFIERPICAEOERET>fUA
EU—H—RERVIBERIT Y IRIETNE A,
H—RERBINLTRTOT—IHNENZATREE NS
WEY., BREYIoRY. h—REKRSEEF. HTFE
BIBZAE)—H—ROFPI ISV THRTETF:
[FHTLTWBZEAHBRLTHSBRIELTLIET W,

o MM TRICAE)—H—RERYEHLEE, AEY—
H—RHBLIG>TVWBRIBENSY EFTHBETIEHY
FtA.

AEU—H—KRZTH+—T vk
(#18A1k) 9%
T4y RENTOROREY—H— R, Ek
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AFA P TCTINE1—T 7 VY —BEHEICKTT
nxtd.
TEOFEICH->TIA—IYRLTET W,

1 Iux=2—0TC/Mediat=2—0
Format Media(94R—>) %FEiR7 3.

2 Media(A) (Ov RA) 7z lEMedia(B) (2
OwkB) ##RLT. 74— w~&ERI(Full
FormatzZ7z13Quick Format) Z#iR7 3,
EERAVvE—INRREINET,

e Full Format : AF ¢ 705 — 4 BB ER
R ThH<FT -9 B2 502452 1Et
L9,

e Quick Format : AF 4 7DF—49 ERE
HAEMEMELE T,

3 ExecuteZ:EIRT 3,
KTPEAYE-—IHRRREIN. PV/EXS
STHRLSAITLET,
TA—IYvEHRTTEE BTAYE-Y
NERRINFITOT, WILFT7VI¥3aY
AL ERLTHELET,

[TEE]

e ATU—H—RETF—TvhrTBE, TRINBRE
F—4. CYRNFYTI7AINREEEL, TRTDFT—
SHEEINET,

o JA—TvhDUEBREICLOTIR., BTPOAYE—
IRRRINEVMBEANABYET,

T# =YY RTETEhoTcEETF

A TERTETRVWAET)—H—RET4—T v
KTEFEHA.
ZEAYE—INRRINETOT. Avt—
ICHEoT. FRATEZAEY—H—RIIKIBLT
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AEETTA—IYRNLIEAT A 7 EA
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5% ) DECER T RERS ) 2 HESS
EEC

R (R /ERFEP) X, Ea—T7r>
S—EmE(11R—) OA/BROY AT AT
REBRREPT, EAOYVRNCESLEAE)—
H—ROBREAMIRTZIENTEET,
REREINTVWBETH 74— v MEERE Y
AL —K) TIRE LB (CELIRTTRE RIS &
FNENOROY MADAT 4 PDEREHSEHE
LTHHMTRRLET,

AE) —H—RORIEEFEA

o SERPIC2MDAEY —H— RORELER T HERS
BOEFNNEZYZE. BEAYyE—ITA
T+ PHREHNDHTHNTT) (Media Near Full)
MBRINER/Y) -S> TDRBETY—
BNy RKRVHA) TEELET,
EBEDHIATAPICKIBELTLEET W,

o SCERA ML T, FRECERTIBERERIDEETH0
CiBE. Avt—IN AT PREHHY F
Al (Media Full) (ZE DY EEMNMEIELF
ERN

[ZEE]

MOAEY—H—RICHWE600BETDI )y TRERTE
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AE)—H—REEETS

ASHORETAE)—H—RADTF—Y CEE
HRELEGZRIE. AEU—H—ROEEHND
BICRYZET,
EBENBBEREAE)—H—REBALEEEIE.
BEEAETIZINESIHZHEETEIAVE-—IH
Ea—T74 4 —BREICERRINET,
BE=ZEITTS
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o IS—NMRELEAEY—H—RIF. T4 -7V
FELETEBEFRTEZHALBYET,

o —ZDIVYTDHHNEETETHVIZELHY
=9, BETEL7)y I IBERREICAYE
7.

(2]

o AMTRBINLEATATIE, A TEELTIRE IV,

o FEUATRBINLEAT A7, FLA—ET
BoTEN—TIVHEEBUBTREINLATAT
4. AR THEETTRVEANRBYET,

o QMUTOIY v T IHEETEE VA,
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EXRNABRTIIROFIRTTVET,

1 pEngErmyATsn. BEARES
NTWBZEARRT S,

AEU—H—REANS,

POWERZA v F%0nICT 3.,
POWERS Y FHEITLT, Ea—T7AY>
H—ICIREBEIRRINET,

4 BESTART/STOPHRY V(5:—) %
Y,
298/ — 5> THEITUT,
VET,

B 2L oF 3

5 agsrrozexa. 15—EamE
START/STOPHKY V&3 d,
SRS AMELE L. AHEIZSTBY(SRERISHE) £—
RicHYET,
[ZxE]
BREANTHSEFURNICERBBSTART/STOPKRY V&
HIE EER/I)—SVTHRMTUSREIREEICAY £ T H,
BIRLTWBREHR T4 —T YN Lo TIIRVIOEFB IE A
FAPICERBINLEVEENHBYET,

AE—hH—KREYVEZS
AEU—H—RH2ZBREEITNTVWS EF(E.
SLOT SELECTRY (6 R—) #IRLTHIY
BZEY,
BREPICAE)—H—RAFLEIAEY—H—K
B) DBRENG<ZZERIIC. BEMICES—H
DAEY—H—RADEZFICTIVEDLYEI()
L—iE8R). AEV—H—RHYgIWBDLBRUIC.
ERBFHOAEY—H—REFHFLOAES—H—
RICRHaT 22 & T P2 LB ER
Fonxtd,

[ZEE]

BEFRLCAE)—D—REZYWEBRZZLFTEEEA, £
20y AEZOY "B FCERBERTETE A

o9y I (ERT—9)
RREFLTZE. FELHSFELEEFTOEEG &
BEAET—9M 1D Iy S ELTAEY —
—NICER&RINFT,

)W FRICDNT
AETERINZ V) vy TOLEIE. TILA
Za—OTC/MediaX=Za2—®DClip Name
Format(93R—2) THREINEATDOT
5NxTd,

7))y T ORKEE]

17Uy T &Y 6BMETTT,
BEOEFIRT TREREG. 7y TORKE
REFEERRTY. REREHV )Y TORKE
BzBz5mE. REZBELCEIEHHICH
LWy THESNET, HLWI Uy T YL
XAOVBEE TRy TELTHRTEET,

UL —RHRTIRIERDO Iy T IERRERLET
. K24KE THEENICFIELET,

[ZEE]

o LBFOAE)—H—RERYHIBVWTLLETV, 8
BFCAEV—H—REANEZZLEFE. 2OV AD
SYTHEILTVWEZOY hDOHFIToTLIET W,

o EBRFPDOAEN—H—ROFKENPRFEOEFIC. B
S—ADZOY N CERIFITELEAE)—H—RHAST
WBE, Ayt—ITFH4<20vMEHIVEZET
MERINET, AEU—H—RXOvrHEIWEDLS
EHRET,

o AEY—H—ROBRENDKRFEOELFICELRERDS
&L UL—EBNTIFRVGEENHYET, ULk
AIELLITOICIF. CCBREABEICAT)—H—ROEE
MU EHZZEABBLTIRETL,

o AifaFE->TL—RRLUELHEIT. A LETIEY—A
LZXBETEEEA.

o KiEFEoTL—RBRLLBEAKESTIICE. VT
ko 7MCatalyst Browsel #FRALT T,

R zE<

ERINZBEEAYRKRYTCEZIY—TFET,
AYRKRVEEF(5R—) Ay REVED
BCEEBINZEFEZEZY—TTET, Fk.
BARTOR—Y) BRAERE—H— (6
R=3) FzFIAYRKVTEZS-—TEFET,
EZV-T2BEOZTEDHFHEIL. AudioX
F—4Z2OVolume(14R—2), FfFIIL
AZa—®OAudioX = 1— >Audio Output®
Volume(99R—2) TITVWE T,
EZY—FBFvXILOFERIEL. AudioXT—
g ZMOMonitor CH(14R—2), £lFT)L
AZa—0OAudioX = a1— >Audio Output®
Monitor CH(99R—3) TITWET,

GALT—4

YALT—R2ZERETS

ERFEINBZIALT—RIE, TIAZ2—DTC/
MediaxX=a1—®Timecode(93R—<) TR
ELET,

A—HY-EvhERETS

StTm16EHE 1I—H—Ew b & UTERMRIC
tTcExd, 21— -y hERERFLICER
EIBZEHAHETY, TC/MediaXZa—®
Users Bit(93R—2) TERELET.

AT —9%RTTD

KRRITB94LT—RIlE. TC/MediaAZa—nD
TC Display(93~<—%’) ®Display SelectT
BELET.
DURATION/TC/U-BITHRED EIY TSN T
BAFTILRY Y (51R—D) 2T &, TR
MIALT—R, 2—H—-Evh, FBIEEOIE
CYIWEBDYET,

HALT—RDAN/ HEN=NVEZS

TCIN/OUTEIWEZ XA v F(4R—) T,
GALT—ROAN/EAEYVEZRZZENTF
*7.

FELLIINER-—IHETELSEET,
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3% &R EFREEFIR

SCEANAEERTA(LYY
LEa1—)

BERIICER LIy TOBGZEE CHR
(LysLEa—) TEET,
(23]

RRBICETA I —TyhEEELLETE, Lyl
E1—-ETEEEA.

Ly LEa—DAE

BFIC T HAFTILRY > OWTNhIcRec
ReviewxEIWHETTHTET,

L& EIELT=5. Rec ReviewhE|WH TSN
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T4 —HhRX %I S
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Y(51R—Y) TERBOBENFIRETT,

o PHAFTILRY > (51R—2) [CPush AF Mode%
EWHTRZEETEET,

o PHAFTILARY > (51R—2) ICFocus Area(AF-S)
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Ea—771 Y I—BEEOERM, IEEES
ANEEYYEDYET,

4 gmomssrhT3.
0000 ~ 9999 D AHTDEEBMA N TEZ
J, #EA{EIZ0000& A >TVWET,
BIEEAAL. RERY SV ELFTILFT 7
VT avILVILERTE, H—YILHR
DHTICBE L%,
FRTOHAEAALLES. H—VILASETIC
BHLET,
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RERY VERFIILFIFOIavEIA
VILERT,

AADNEELET,

BREMNTET LAy E—INRREIN.
UserAZa—KRRICYIWEDYET,

AZa—0Ov I %fERT S

TIWAZ 21— DBIEAE

1 wuzzrvrvavaqvLamians

5 sggovsrrwizorassavey

YILEIRT,

ANHDHEELET,
AZa—AOvILIEEFDRBIHESEAA
LEBSH—BLIEES. OvIHERT
FZEDAZI-RRICYIVEDYET,

[TE=E]

MENURY > & R#RLT 3. .

2 UserAZ a—®MMenu Settings®User

Menu with Lock%#iR9 3,

[TEE]

MENURY > OHERIFLLTEEDIIAZ 2—%
FRLKEIBA. TechnicalAZa—®dMenu Settings
IZIZUser Menu OnlyWRREINET M, YILFT7
272 aVIALVILERLGNSMENURY VA E#H
Ld3&. User Menu with LockhRREINE T,

Off & BIRLTRERY VE 2 ITILF T 7
22 aAvILYILERT,
Ea—TJ714 V9 —BEOERRN. BEiIES
AAEEICTIVE DY ET,

AZa—%0OvILIEEDESEANT
3,

BEEZANDL. RERIVEREETILFT7
2T AVIALVILERTE, H—VILHR
DOHTICHELET,
TRTOHTEAALRES, h—VYILHSetIc
BEILET,

AZa—%#0v I LIESDBAFESEANLLEESH

A—BOGZEE. OvIZ@ERTEERA.

BAHESIE. TNEETDeH. FRICERBRERITIL
ZHEOHLET, TNEFTFY-—EXROCEBVWE
pELETV,
TROTIWAZ1—DAZa1—-IEH%ZUserA Za—[c&
BETICAZa—2OvILERE. RREETYCF
TIURIVICRET B LB TEEREA,
TROWEEATYAFTILRI Y CTHA VLTV
Bl AZa—%20YILEBRTFHIFTILORE

TIAZa—DAZa— TFPHAFTIKRI> TNAZa—DAZa— TFPHAFTILKRI>
HH DEEIRAE HH DR
Shooting>White> Preset White Monitoring>VF VF Mode

Preset White Select Setting>Color Mode

Shooting>Focus>
AF Transition Speed.
Shooting>Focus>
AF Subj. Shift Sens.

AF Speed/Sens.

Monitoring>Gamma

Gamma Display

Shooting>Focus>
Focus Area

Focus Area

Shooting>Focus>
Focus Area(AF-S)

Focus Area(AF-S)

Shooting>Focus>
Face/Eye Detection
AF

Face/Eye
Detection AF

Display Assist
Assist>Setting

Monitoring> Peaking
Peaking>Setting

Monitoring> Zebra
Zebra>Setting

Audio>Audio Volume

Output>Volume

Shooting>Focus>
Push AF Mode

Push AF Mode

Technical>Touch
Operation>Setting

Touch Operation

HEaHIBICOfflc Y £ g,

Technical>Handle
Zoom>Setting

Handle Zoom

Shooting>S&Q S&Q Motion
Motion>Setting
Shooting> SteadyShot

SteadyShot>Setting

Project>Picture
Cache Rec>Setting

Picture Cache Rec

INAZaA—DAZa— FHAFTILIKI>
HE DFERAL
Shooting>ISO/Gain/ Base ISO/
El>Base Sensitivity.,  Sensitivity
Shooting>ISO/Gain/

El>Base ISO

Shooting>Auto AGC
Exposure>AGC

Network>Wireless NFC
LAN>NFC

Network>File Auto Upload
Transfer>Auto (Proxy)
Upload (Proxy)

User User Menu

Auto ND Filter

Shooting>Iris>Bokeh
Control

Bokeh Control

Shooting>Auto

Auto Shutter

Exposure>Auto

Shutter

Shooting>Auto Auto Exposure
Exposure>Level Level
Shooting>Auto Backlight
Exposure>Mode

Shooting>Auto Spotlight

Exposure>Mode

Technical>Rec Rec Review
Review>Setting

Thumbnail>Set Clip  Clip Flag OK
Flag=Add OK

Thumbnail>Set Clip  Clip Flag NG
Flag>Add NG

Thumbnail>Set Clip Clip Flag Keep
Flag>Add KEEP

Technical>Color Color Bars
Bars>Setting

Monitoring>Display  Lens Info
On/0Off>Lens Info
Monitoring>Display  Video Signal
On/0Off>Video Signal Monitor
Monitor

Monitoring> Marker

Marker>Setting
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UserA=a1—

BAZ1-—TEEBLUNIS T 2EEEFUTDES YT,

User

AZa1-—I8H

AE

Base Setting

Project > Base Setting® A,

Focus Shooting > Focus®OA A,

S&Q Motion Shooting > S&Q Motion®OARA,
LUT On/Off Shooting > LUT On/OffO A,
Simul Rec Project > Simul RecOARA,
Proxy Rec Project > Proxy RecODRA,
Interval Rec Project > Interval RecDAA,

Assignable Button

Project > Assignable Button®R A,

Assignable Dial

Project > Assignable Dial DA,

Multi Function Dial

Project > Multi Function Dial DA,

All File

Project > All File®d A A,

Clip Name Format

TC/Media > Clip Name Format®OR A,

Format Media

TC/Media > Format Media® N &,

VF Setting Monitoring > VF Setting® W&,
Zebra Monitoring > Zebra® A&,
Zoom Technical > ZoomDA A,

Menu Settings

Technical > Menu SettingsORA.

Edit User Menu

Edit UserAZa1—%&RRT 3,

[TE=E]

UserA=a—I[tEditUserA = a—IC £ o TAZ 21— IBHDBMPHIRHATEE T,

RETETZREMG 20N LRETT,



77

68 AZa—FRREFHMRTE

Edit User A= 1—

UserA = a1—TEdit User Menu%:&iR9 3 &, Edit UserAZa—HEIREEBICRRINET,

Edit User
AZa1-—I8H B LK EE AR
Add Item UserAZa—(CE2MEEBOER B

UserAZ1—IEH®EM

EEGH

Customize Reset
UserA—a—IEH®DY
vk

UserAZ1—DEFRIEB%Z TIHHE
BDIREICRET,

REPIGEIRLIEE2ME  Delete
BnIER

UserAZa—IcERLIE 2B DIA
BaHIFRT 3,

Move

UserAZ 1—[CERULEIBEER2 LAY
Z5.

Edit Sub Item

UserAZa1—[cEF L EIRBEDIE
BIcE I 2B % mEER - HIFR) o
5,
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ShootingAZ=1—

EAZ1-THHOWES LUREMERIUTOESY TT,
TimHER QYR EMEIZ. AXF(H):18dB) TRLET,

Shooting>ISO/Gain/El
TAVICEATEREETVET,

Shooting>ISO/Gain/El
TAVICEATEREETVET.

AZa—-1HH MBEEREE

RS

AZa1—-IBH MIBLHREE ABE
Mode ISO/dB TAVREE-—RZ2BEIRT 3,
ISO/ SREERICDVWTELLIE, TISO/Gaint  #o4>DF )ty ME<H>%2RET 3,
Gain<H> Za—OREBEEMEAE (109R-Y) %
TECREL,
ISO/ FREBEBICDWVWTEELLIE. TISO/GainA TA4oDF) Yy ME<M>%ERET 3.
Gain<M> Za—-OREBEEMHAE (109R-2) %
BT,
ISO/Gain<L> SREBEHICDWTEELLIE. TISO/GainA TAODT) Yy ME<L>%RET 3.

Za—OREBEEMEAE 109R-) %
BT,

Exposure
Index<H>

Base ISOAISO 800 &+
200El / 4.0E
250El /7 4.3E
320El / 4.7TE
400El / 5.0E
500El / 5.3E
640El / 5.7E
800EI / 6.0E
1000El / 6.3E
1250El / 6.7E
1600El / 7.0E
2000El / 7.3E
2500El / 7.7E
3200El / 8.0E

Base ISOHISO 12800 & F
3200El / 4.0E
4000El / 4.3E
5000El / 4.7E
6400El / 5.0E
8000EI / 5.3E
10000EI /7 5.7E
12800El / 6.0E
16000El / 6.3E
20000E1 /6.7
25600El / 7.0E
32000El / 7.3E
40000El /7 7.7E
51200El 7 8.0E

Exposure Index<H>%RET 3.
Cine EIE—REOHBEMTT.

Exposure
Index<M>

R EfEIFExposure Index<H>¢RLTT,
Base ISOAYISO 800 &
1000E! / 6.3E
Base ISOAISO 12800 & F
16000El / 6.3E

Exposure Index<M>%E&E 9 3.

Exposure
Index<L>

SR EfE[FExposure Index<H>¢,RL T,
Base ISOAISO 800 & F

800EI / 6.0E
Base ISOAISO 12800 &+

12800EIl / 6.0E

Exposure Index<L>%5RE ¥ 3.

Shockless
Gain

On / Off

N

>

IwILRTA VREARON/Off T %,
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Shooting>ISO/Gain/El
TAVICEATEREETVET.

Shooting>Shutter
Bf vy y—DEFRGEZRELET,

AZa-1HH MBEEREE

AE

AZa-—1H MBEHREME

RS

Base High / Low SDR/HDRE—RANEEREZRET
Sensitivity 3.
Base ISO I1SO 12800 / 1SO 800 Cine EIE—FRADEEISOREZRET

%,

Shooting>ND Filter
NDTZAIIWY—DT )ty MEZRELET,

AZa1—-IHH MEEREE

RE

Preset1 174 /1/8 /1/16 /1/32/1/64 / 1/128 NDTAIILY—DF Uty MOERRET
2.

Preset2 1/4/1/8/1/16 /1/32/1/64 /1/128 NDTAIILT—DF Ity N 20 EZRE
2.

Preset3 1/4/1/8/1/16 /1/32/1/64 / 1/128 NDT ALY —DF )y N3DERRE

%,

Shooting>Shutter
BF vy I —DEEREEZRELET,

AZa1—1RH MBEREE

RE

BF v vI—DE—REEIRT S,

BT ORVHEEFREEBICIRELEVGS
BEICFERTZ, BRTIvvI—RES
RETBSpeed(RE—R) E—REHAE
Tovyd—REEHZRETDANgle(BE)
E—R%ERIRT 3,

Mode Speed / Angle
Shutter On / Off
Speed

On/Off

SpeedE— REIREFOTENIFE &,
Shutter Speed DEREMEICRESMTILEN
ICTZNEHRET S,

Shutter
Speed

64F ~1/8000
REEF. BIREINTVWBET AT+ —T
NOTL—LRBARBICL>TERYVET,
59.94P:
64F / 32F /16F / 8F / 7F / 6F / 5F /
4F /3F/2F /1/50/1/60 /1/100 /
1/120 /1/125 /1/250 / 1/500 /
1/1000 /1/2000 / 1/4000 / 1/8000
50P:
64F / 32F /16F / 8F / 7F / 6F / 5F /
4F /3F/2F /1/50/1/60/1/100 /
1/120 /1/125 /1/250 7/ 1/500 /
1/1000 /1/2000 / 1/4000 / 1/8000
29.97P:
64F / 32F /16F / 8F / 7F / 6F / 5F /
4F /3F/2F/1/30/1/40/1/50 /
1/60 /1/100 /1/120 /1/125 /
1/250 /1/500 /1/1000 / 1/2000 /
1/4000 / 1/8000
25P:
64F / 32F /16F / 8F / 7F / 6F / 5F /
4F /3F/2F/1/25/1/33/1/50/
1/60 /1/100 /1/120 /1/125 /
1/250 /1/500 /1/1000 / 1/2000 /
1/4000 / 1/8000
24P/23.98P:
64F / 32F /16F / 8F / 7F / 6F / 5F /
4F /3F/2F/1/24/1/32/1/48/
1/50/1/60/1/96 /1/100 / 1/120 /
1/125 /1/250 /1/500 / 1/1000 /
1/2000 / 1/4000 / 1/8000

SpeedE—RNZEREF, Yvvy—IE—RK
ERET D,

Shutter
Angle

64F / 32F /16F / 8F / TF / 6F / 5F / 4F /
3F / 2F 7/ 360.0° 7/ 300.0° / 270.0° /
240.0° / 216.0° 7/ 210.0° / 180.0° /
172.8° /150.0° / 144.0° /120.0° /
90.0° /86.4° / 72.0° / 45.0° / 30.0° /
22.5°/11.25° / 5.6°

Angle®—R #EiRF HAEAZRTETS.

ECS On/Off On/ Off

Extended Clear Scan®RE%On/Off ¥
3.
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Shooting>Shutter
BF v vI—OEERGEERELET,

Shooting>Auto Exposure
BEIBHAROREZTVET.

AZa1—18H HMBEREE AR AZa1—1HE HMBEHREE AR
ECS 23.99 ~ 8000 ECSE—N &IREE. ECSARBARET 3., AGCLimit SBEBEBICOVWTHELLIE. TAGCLIMitA AGCHEEDR AL (> EBRET 3.
Frequency EREMEIF. BIRTNTWBETH T4+ —T v Za—OREBEMERME MNMR-I) %
FOTL—LARBICE>TERYET, BTV,
VIFEIUATDOEEY TT, AGCPoint F2.8/F4/F5.6 AGCHgEENOND E*, AGCEEIET BB
59.94P:60.00 HBETAIIDFERRET 3.
>0P:50.00 Auto On/ Off A—Rvys—a> NO—)LiEEOn/
29.97P:30.00 Shutter Off93
23.98P:23.99 °
25p - 25.02 A.SHT Limit 17100 /1/150 / 1/200 / 17250 / 1/2000 7#— kw5 —HEEDRES v v 45—
24P:24.02 E-RFE&ET S,
_ _ A.SHT Point F5.6/F8/F11/F16 A= vy I —AEET BIADZ TR
Shooting>Iris DFHMEZRET S
N REEEEDREERITVET, Y = g ° =)
Y—a_EH MECREE e Clip High On / Off BIEEHOEEZBRLT. BEECHT
-2 lalsisl s — light BRI #H< T ¢ #EEROn/Off 3 3,
E"kfhl On / Off A7 BEAEAEZ On/Off 9 3, Detect 1/2/3/4/5/6/ Custom BEHOBAZ T (OB TELEBBHE
ontro Window TR EEERIRT 2. (BHEFEA
Shooting>Auto Exposure BLTVWREE(EER)
BEEHAROREETVET, Detect On / Off AEEEOZRTZON/Off T3,
AZa1—-1H MBEFREE AE Window
Level +3.0/+4275/+2.5/+42.25/+2.0/ BENRHE L BHICN T3 EIEL AL AR Indication
+1.75/ 1.5/ +1.25 / +1.0 / +0.75 / T3, Custom 40 ~ 999(500) RIEEDIEERET S,
+0.5/+0.25/+0/-0.25/-0.5/ Width
-0.75/-1.0/-1.25/-1.5/ 175/ Custom 70 ~ 999(500) BINEEDOETERET B,
-2.0/-2.25/-25/-275/-3.0 Height
Mode Backlight / Standard / Spotlight BEELALOHMEE—RERET 3. CustomH —479 ~ +479(%0) BINEEDOKEMBERET S,
Backlight: Position
NS4 E—R(FROEHBZHEER A " e
CustomV  —464 ~ +464(+0 A DEBENBHRS \
DL E. B i AT BT F’uslqm +464(£0) ANEEOEEMBA#RETS
k) osition
Standard:
FEE-—R
Spotlight:
ZiRY hSA R E—R(BLEHRZHEE
RICZRy hSA MhYfcoTWVWB E
T BENEERITZIE—NR)
Speed —99 ~ +99(+0) H}EHAZEORAEIE—-RNE2ERET 3.
AGC On / Off AGC(A—K4Z4>a> hO—)L) #te

On/0ff¥ %,
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Shooting>White
RIAMNSVRDBREEITVET,

Shooting>White Setting

RIA NS VZOBEEITVET,

AZa-IHH MBEEREE

RE

AZa-1HH MBEEREE

S

Preset 2000K ~ 15000K(3200K)
White

RIAMNSY2OT )y MEARET
3.

Color Temp 2000K ~ 15000K(3200K)
<A>

AEY = ACREFEINIZARTA NSO
BEREZRETS.

[ZEE]

Color Templ&. R/B Gainig{EBF(C2000K¥
15000KTY ) wFE N3k, R/BGainfEd
1IERE7Color TempfEx RN TIRWIGENEHY
F7.

Shockless off71/2/3
White

RTINS VRE—RYIWEBZBEORT A

MSUZRECERERRET S,

Off : BREFICEIW EDH 3.

1~3: HENAAETVEFED KWW ED
3

ATW Speed 1/2/3/4/5

ATWE—-RFRORIGEEZRET 5.
1: BB RIGERE AR,

Tint<A> —99 ~ +99(+0)

RIARAE — AICRFE NIRRT A R
SVRADTINtEZRET 3.

[ZFE]

Tintld. R/B GainiR{FBIc+99T/ Vv Eh

3718, R/B GainfEQEHLTINt{EZRRTT
BRWMEEHBHYUET,

White Memory / ATW
Switch<B>

WHT BALZA v FABICREL I & ¥ (3R
RENBHRTA NSV RBEE— R %5E
R 3.

R Gain <A> —99.0 ~ +99.0(+0.0)

AT = ACRESNIRTAMNS VD
RTAVERRET 3,

B Gain<A> —99.0 ~ +99.0(+0.0)

AT = AICREITNIRTA RS VD
BYA U iEZERET B,

ColorTemp 2000K ~ 15000K(3200K)

<B>

AEY = BIZREINLERTA NG VD
BREZRETS.

[T3EE]

Color Templd. R/B Gaini®{Es$IC2000K+>
15000KTo Uy FEN3T=s. R/B GainfED
1IERE/RColor TempfEk RRTITREWEEHEHY
7,

Filter White On / Off
Memory

NDT ALY = EICHRTA NS UIAE
) —TEig A B E T BHEEZ ONn/Off 93,
On:NDIZAIWY—=&ICKRTA RISV
AEY—%FRET S,
[*¥E]
Tty R E—RDOEFECLEAR/1/2/304
#H. N\UPTILE—RODEFIFCLEAREON
D2AERYVET,
Off : END T ALY —THRITA RISV A
EU—I3HE,

Shooting>0Offset White

RTINS UZADA T LY NDREETVET,

AZa—-1HH MEEREE

RS

Offset White On / Off
<A>

AEY = ADKRTA NSO ATEY b
8% 4109 %(0n) HMILZEVH(OFf) %
BEiRT 3.

Tint<B> —99 ~ +99(+0)

RIARAEY— BEREFEENIARTA BN
SVADTINHEZRTET .

[ZixE]

Tintld, R/B GainiRfFBFIC£99TIUvTEh

%7z, R/B GainfEDERATINtEEZRTTE
BWMEEHBHYET,

Offset Color —99 ~+99(+0)
Temp<A>

Offset White <A>HOnDIFHIC. AT
U= ADKRTA MNSYVRCHMTZER
EAROA Ty ZERET S,

Offset —99 ~+99(+0)
Tint<A>

Offset White <A>HONDIZEIC. AE
)— ADKRTA MNSVR IS BTintA
BOA 7ty ERET S,

R Gain<B> —99.0 ~ +99.0(+0.0)

AEY—BILREINRTAMNSVRD
RTA U MERRET 3,

B Gain<B> —99.0 ~ +99.0(+0.0)

AEY = BILREINLARTA NSO
BV A E%RET 2.

Offset White On / Off

<B>

AEY = BOKRTA NSVRCATEY H
&% 109 %(0n) HMILZVH(OFf) %
BEiRT 3.
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Shooting>Offset White
RIARNNSOZRDATEYRDREETVET,

Shooting>Focus
T+ —hADFREZITVET,

AZa1—-IBH MIBLHREE AE AZa1-IBH MIBELREE NE
Offset Color —99 ~+99(+0) Offset White <B>HOnMDiFEIC. AE Face/Eye Face/Eye Only AF / BERRHAFOBM/BIERTET 3.
Temp<B> 1)— BDRTA NSRS 3EE Detection  Face/Eye Priority AF / Off

EABOA 7ty h%2RET S, AF
Offset —99 ~+499(%0) Offset White <B>hOnDIFEIC. AE Push AF AF / Single-shot AF(AF-S) JZa7INI+—hRBDTyvar—k
Tint<B> )= BORTA NS URIAFMT BTintA Mode T+—HADE—-—RERET S,

MOAT LY N ERET S, Touch Tracking AF / Spot Focus I aATPINTA—DRBCY v FIZIL%E
Offset White On / Off ATWODRDA MNSURICATEY MEE Function in Gy T LI T DEMEERET 3.
<ATW> 109 %(0n) ML AR WVHV(OFF) %5384R MF

EECE AF Assist ~ On / Off ONCHRETZE. A—hTH+—H 2B —

Offset Color

—99 ~+99(+0)

Offset White <ATW>HMOnDIBEIC.

RHNICFETIA—HREEDERIEN
TE3.

Shooting>S&Q Motion

Z20—&JAYIE—YavE—RDBREEITVET(52R—-),

AZa—-1EH MBEEREE

S

Setting On / Off

20—-& A4y I7E—3a>E—-R&0n/
Off93.

OnDEF, UTOWBENEINICARVET,
* F—KPAUR

* F—RJ#—HZX

Frame Rate 1fps ~ 60fps / 100fps / 120fps /

150fps / 180fps / 200fps / 240fps

20—-&TAVIE—YaviREBRBEOTL —
LL—ERET S,

[TEE]

BREMOEHRH ., BIRTNTWBEIITLEARE
WYA-Fvy, EFFTF—IvRMCL>TERY
E3 N

Shooting>LUT On/Off
LUTOREZTTVET.

AZa-—1H MBEEHREME nE

SDI/HDMI MLUT On / MLUT Off SDIE L UHDMIE AR ICMonitor LUT
HEBAT3MERT 3.

VF/Proxy/  MLUT On / MLUT Off VF. Proxy$® & U'Streamd A4 (C

Stream Monitor LUT#ER T 3H&EIRT 3,

Temp ATWORTA MNUSVR IS 2ERE
<ATW> ARAOA Ty NEHRET S,
Offset —99 ~+99(+0) Offset White <ATW>HOnDIFZE .
Tint<ATW> ATWDHRTA NS URICFNT 2TintA
BOZA Ty ERETS,
Shooting>Focus
T —hADFREZITVET,
AZa-1HH HMBLEREE AE
AF 1(Slow)/2/3/4/5/6/7(Fast) A=K7 A —HhABhOHBEFREIBUEDS
Transition BOT4+—hZABBORTEFZET 3.
Speed
AF Subj. 1(Locked On)/2 /3 /4 /5(Responsive) #—KI#—HZHDHEEAKRDRTEY YR
Shift Sens. EER/ET 3.
Focus Area Wide / Zone / Flexible Spot FT—hTH—hR. Fy>az—hTx—2h
Z(AF) xR E T BB ERET S(40
R—=),
Wide:
RIE2EMNST+—H2EEDLESR
BxRT,
Zone:
BELEY-—VRMSEETIA—HR
ZEaOEZIREET.
Flexible Spot:
BRIEDIEELILMUBICIA—HRER
b3,
Focus Area Flexible Spot Ty a7d—hT#—HhR(AF-S) DFtHRE

(AF-S)

YRMEERET B,

Internal Rec  MLUT On / MLUT Off

A SCERIRIK (CMonitor LUTRERT3
M&ERT 3,
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Shooting>Noise Suppression
A XY TLADRERITVET,

[AE]

Setting(Custom)&Level(Custom)DEREfEIEZNZNTarget DisplayDi&EICKMENFE T (113 R—).,

AZa—IFH HMBEEREE

RE

Setting On / Off CustomE—REFD ./ XY L X gHER
(Custom) On/Off¥ %,

Level Low / Mid / High CustomE—REO /A XY TLIADLAR
(Custom) IWAERET S,

Setting On / Off Cine EIE—RBED /1 XY FL A HEE
(Cine EI) On/Off¥ 3,

Level Low / Mid / High Cine EIE—RBO /A XHTFLADLANIL
(Cine EI) HRET S,

Shooting>Flicker Reduce
Ty H—FEDREEITVET,

AZa-—I88 MBLREE

AE

Mode Auto / On / Off

Ty h—HEE—RERET S,

Frequency 50Hz / 60Hz

7y h—DRAE LB RADOEIRE R
ZRET 3.

Shooting>SteadyShot

FILBEDOEREEZITVET,
AZa—-IEH HMB&LEREE NE
Setting Active / Standard / Off FILBERELZRTET 3.
[ZFE]

MISL Y XEEROHRETTET.
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Project AZa1—

EAZ1-THHOWES LUREMERIUTOESY TT,
TimHER QYR EMEIZ. AXF(H):18dB) TRLET,

Project>Rec Format
KBTI YNDOREEITVET,

AZa—-1HH MBEEREE RS

Project>Base Setting

- P Vi F E '-.-‘:l\\ STCE ° L) — Y BT °
EARTEGNET F(l)(?emc;t Frequencyt(cio:ecd)&Eligf;l;;gb% BRETA+—IvNERETS
AZ1-HH MECREE o S;e;‘:ency RZV\T/‘
Shooting Custom / Cine El REE—RERETS. (25/_-) ' RAW(HDMI)
Mode
Target SDR(BT.709) / HDR(HLG) CustomE— R ORR/ HADE R RAWS — 4096x2160P
Display =93, XAVCI 3840 2160P
X
Project>Rec Format E(AX\%/HC?IMU 3840x2160P
SR IA—VYMDREEITVET, YAVC. 4096 X 2160P
Frequency 59.94/50/29.97/25/24/23.98 AT LRAREBEEIRT S, W
- - X
Imager Scan FF / S35 EFRTGHHUAREER/ME) & AA—
Mode I —YA IREEMBEDE D SERT XAVC-L  3840x2160P
3. 1920X1080P
Codec RAW / RAW & XAVC-1 / RAW(HDMI) / R -BEE-—RERETS, 50
RAW(HDMI) & XAVC-1 / XAVC-1 / 1920X1080P
XAVC-L 35
RAW Output Frequency&CodecDEREICRUTEDLZ, RAWHEANTZBIBERRET S, 50 RAW/ —
Format Frequency Codec IR (2538 RAW(HDMI)
59.94/ RAW 4096X2160  CodechHRAW & XAVC-IDEF (4. Video RAW & 4096x2160P
50/ 3840%2160  FormatARAW Output FormaticsL ]y XAVCI 3840%2160P
;2./97/ AW & 2096x 2160 BPYET. RAW(HDMI) 3840%2160P
23.98 XAVC-I 3840%2160 & XAVC-I
: - X
RAW(HDMI) 4240X2392 XAVC %
X
RAW(HDMI) 4240X2392 -
& XAVC-| 1920X1080P
24 RAW 4096X 2160 XAVC-L 3840X%X2160P
RAW & 4096% 2160 1920x1080P
XAVC-I 50—
1920X1080P

35
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Project>Rec Format Project>Rec Format
BTV YRDOREEITVET. BTV Y ROREEITVET,
AZa-15H MBEELHREE NE AZa-IEH MBELHREE NE
Video 29.97 RAW/ — Video 23.98 RAW/ —
Format RAW(HDMI) Format RAW(HDMI)
RAW & 4096X%X2160P RAW & 4096X2160P
XAVC-| 3840x2160P XAVC 3840x2160P
RAW(HDMI) 3840X%2160P RAW(HDMI) 3840%2160P
& XAVC-I & XAVC-I
XAVC- 4096X%X2160P XAVC-| 4096X2160P
3840X2160P 3840X2160P
1920X1080P 1920%X1080P
3840X2160P XAVC-L 3840X2160P
1920X1080P 1920X1080P
50 50
1920X1080P 1920X1080P
35 35
25 RAW/ — 24 RAW/ —
RAW(HDMI) RAW(HDMI)
RAW & 4096X%2160P RAW & 4096X2160P
XAVC 3840x2160P XAVC-I
RAW(HDMI) 3840%2160P RAW(HDMI) 3840%2160P
& XAVC-| & XAVC
XAVC-| 4096%2160P XAVCI 4096x2160P
3840X%X2160P Project>Cine El Setting
1920%1080P Cine EIE—ROBREEITVET,
XAVC-L 3840X2160P AZ1-EE MELBTE Rz
1920%1080P Color Gamut S-Gamut3/SLog3/ Cine EIE—FROBEHERET S,
50 S-Gamut3.Cine/SLog3 S-Gamut3/SLog3:
1920%1080P Cine EI€— RO &EZS-Gamut3
35 ICERET 3.

S-Gamut3.Cine/SLog3:
Cine EIE— RO &EE%S-Gamut3.
CinellE&ET 3.
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Project>HDR Setting
HDRE—RODBREEZTVET.

Project>Interval Rec
AV —=INILL Y I DFFEEITVET(53R—),

AZa—-1HH MBEEREE

RE

AZa—-1HH MEEREE

RS

VF SDR On / Off HDRE—RBETHYIERTRTZIANDES
Preview HEFE1—T AT —RIGEBZHIC
HDRMSSDRICERLIEMURTRRT S
#EEHONn/Off 973,
[XE]
OnNDEFFE2—T 74 >4 —BKIZSDR Gain
MNERINET,
SDR Gain 0dB ~ —15dB(—6dB) HDRE— KBS TVF SDR PreviewhOn®

EE Ea-—T7A V- CERITNSBSDR
GainDERRET 3.

Number of  1frame / 2frames / 3frames /

Frames 6frames / 9frames / 12frames
BIRETNTVWBET AT —TvhDTL—
LEBEBICETREENERLGYET,
59.94P/50P:

2frames / 6frames / 12frames
29.97P/25P/24P/23.98P:

1frame / 3frames / 6frames /

9frames

Interval RecOEREHMNONDIFEIC, 1>
S—NILIBREEOIEORRIL — L%
BRET S

Project>Simul Rec
EERECROBEEITVET(54R—),

AZa-1HH MEEREE

Az

Pre-Lighting Off/2s/5s/10s

A9 —=NILLy VIR HBKICETA S
A1 ERITTE2GEIFAMFICRITTE
2hEFERT 3,

[AE]

HVL-LBPC(BII3E) A D H B MR E T,

Setting On / Off AHRFERFSCEREEED ONn/Off & ERERFE A
T4 T E—FERET D,
Rec Button Rec Button:[SlotA SlotB] Handle SERAT AT ZEICRERY VDEY YT

Set Rec Button:[SlotA SlotB] / Rec
Button:[SlotA] Handle Rec Button:
[SlotB] / Rec Button:[SlotB] Handle Rec
Button:[SlotA]

= =

172,

Project>Picture Cache Rec

EVFv—FvyPalyvIE—ROREEITVET(G3R—Y),

Project>Proxy Rec
TOFYERE-—ROFREEITVET,

AZa-1HH MBEEREE

AE

Setting On / Off JOFVERE—RKE0n/Off g3,
Audio CH1/CH2 / CH3/CH4 TOFSF—YICRFIBRA—FTA4HFF v
Channel DRI EEIRT S,

AZa-IEH MELEERE nE

Setting On / Off EV9Fv—FvyPalyvVE—-KEO0On/
Off93,

Cache Size  Short / Medium / Long / Max EVFv—F vy IaXE)—CEGEE
BIAEE(Fvyy>alyIRBIFICTH
DIFZH5MH) 2H/ET 2.

Cache Rec EI9Fv—FvvIaXE)—ICEEES

Time BIAEE(Fvy>alyIRBIICTH

DIFZHE) ERRT B,

Project>Interval Rec
A= INILLY I DREZTVET(53R—Y),

AZa-—I88 MBLIREE

RE

Setting On / Off A9 —=)NILLYTE—R%0On/Offg 3,
(ZO|EEONCT D L. MDD
E—ROFEMOffIcESB.)

Interval 1/2/3/4/5/6/7/8/9/7/10/15/ Interval RecDFREHMNONDHZHIC. 1~

Time 20/30/40/50(s) 4 —VLIRF B OSRERRE(r > 9 —/CL)

1/2/3/4/5/6/7/8/9/10/15/
20 /30 /40 /50 (min)
1/2/3/4/6/12/24(h)

ZRET B,
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Project>SDI/HDMI Rec Control
SDI/HDMIEESEHEDEREEITVET,

Project>Assignable Button
FYHAFTILRY ARV Y TEREEITVET,

AZa—-1HH MBEEREE

RE

AZa—-1HH MBEEREE

RS

Setting Off / SDI/HDMI Remote I/F / Parallel
Rec

SDI/HDMIHAES IC L B9 BRI Scilss D

R/MFLERIEERET S,

Off:

UE—RHIELZW,

SDI/HDMI Remote I/F:
AEICAT 4 P HEIBALTVEVIREE
T. HNEBIEfGTEES DR /FIEHIEA
aJEE, AEDATAPETL—LBET
FIHAL AR,

Parallel Rec:
AEICAT 4 P HBALTVWBIRET.
SEBIE TR 2R DL R /F L HIE AV AT
BE. AEDAT A FETL—LBEETH
93,

[TEE]
HDMIHAES [ L2 EHZITSHEEIF. TILA
—a—®OTC/Mediax=a— >HDMI TC Out®
Setting(93R—) Z#OnICERELTL LTV,

<1> ~ <9>,
Focus Hold
Button

Off / Base ISO/Sensitivity / AGC /
Push AGC / ND Filter Position / Auto
ND Filter / Push Auto ND / Auto Iris /
Push Auto Iris / Bokeh Control /
Auto Shutter / Auto Exposure Level /
Backlight / Spotlight / Preset White
Select / ATW / ATW Hold / AF
Speed/Sens. / Focus Setting / Focus
Area / Focus Area(AF-S) / Face/Eye
Detection AF / Push AF Mode / Push
AF/Push MF / Focus Hold / Focus
Magnifier x3/x6 / Focus Magnifier x3 /
Focus Magnifier x6 / S&Q Motion /
SteadyShot / Rec / Picture Cache
Rec / Rec Review / Clip Flag OK /
Clip Flag NG / Clip Flag Keep / Color
Bars / Tally [Front] / DURATION/
TC/U-BIT / Display / Lens Info /
Video Signal Monitor / Marker / VF
Adjust / VF Mode / Gamma Display
Assist / Peaking / Zebra / Volume /
Thumbnail / Touch Operation / Handle
Zoom / NFC / Auto Upload (Proxy) /
Direct Menu / User Menu / Menu

FHAFTILRY v IcHaeRE|Y LTS,
Base ISO/Sensitivity :
AA=I I —-—DREEREDOYIVEZ
AGC:
AGCHEEDON/OfftIUE X
Push AGC:
R UERLTWSE. AGCHEEE.2E
T3
ND Filter Position:
NDZ7 4L —DEIWEZ
Auto ND Filter:
Z—KND 7 1LY —®DOn/OffENEFY]
WEZ
Push Auto ND:
R VEBLTWSE. 27—KND7«
LY —tREEE BT S
Auto Iris:
A ZHEEDON/OffIWE X
Push Auto Iris:
R VERLTWBE., 7—hPAUX
WEEEBMICTS
Bokeh Control:
KT RABE—RDOn/OffNWEZ
Auto Shutter:
F—ho v vy —EEDON/OffIWE X
Auto Exposure Level:
Auto Exposure Level 41 L& kX
Za—-hERBR/MKRTTB
Backlight:
Backlight/StandardtlW#z
Spotlight:
Spotlight/StandardtW&x
Preset White Select:
ROA NSV Ty R E—RED
YWEZ
ATW:
ATWHBEDON/OfftNWEZ
ATW Hold:
ATWHSBEDENEE —BFR—ILR
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Project>Assignable Button
THAFTILRY OAOEEEEIY B TEREEITVET,

Project>Assignable Button
FYHAFTILRY ARV Y TEREEITVET,

AZa-—18H MBEHREE AE AZa-1H MBEHREME nE

<1> ~ <9>_ AF Speed/Sens.: <1> ~ <9>_ Clip Flag OK:

Focus Hold AFRS YT YavREDRTEEAFEY Focus Hold Add OKEZEfTT S

Button BYREDOREDOYIVEZ Button 2%+ T g & Delete Clip Flagx =

Focus Setting:
TH+#—HAITVTFOREZTD
Focus Area:
AF. v a1 AFRDT74—HXIVU7F
DEREETTD
Focus Area(AF-S) :
v a AF(AF-S)BDT7#—hZ TV
TDEREETD
Face/Eye Detection AF:
BR/IERHAFOREETVEZS
Push AF Mode:
Push AFOE—REBEZTIWEZS
Push AF/Push MF:
T —HAXE—RHMFEE, RY>A#H
LTWBRIZAFICHES
TA—HZE—RDAFE, K9 V%18
LTWBRIEMFIC/E3
Focus Hold:
T#—HAE—RHAFEE, 1Y%
LTWBE T+ —HhAZBEET S
Focus Magnifier x3/x6:
Focus Magnifier x3:
Focus Magnifier x6:
E> MEKEBEDON/OffHIWE X
S&Q Motion:
20—& T4 YIE—aVEEEDON/
OffgIuE x
RIFLTEREBFOIL—-LL—FDER
£
SteadyShot:
Active / Standard / Offlu &z
Rec:
SRR EIFFELE
Picture Cache Rec:
E9Fv—FvvIalyvIE—RD
Oon/Offlu &z
Rec Review :
LvZLEa21—DOn/OffgiuWEZ

79%

Clip Flag NG:
Add NGEZEFTTS
20517 TH 9§ &Delete Clip Flaga %
795

Clip Flag Keep:
Add KeepZEfT9 3
205+ T & Delete Clip Flaga=®
79%

Color Bars:
HS5—/—D0On/OffIUEZ

Tally [Front]:
28/9)—5>F (Front) DR, =
BIEBEDON/OffYIW E X

DURATION/TC/U-BIT:
Time Code/Users Bit/Durationt])
B2

Display:
BEZROON/OffIWEZ

Lens Info:
HERREXRTOUVIVER

Video Signal Monitor:
BIEESEZY— (REEZY -1 L)
DRTRYIVER

Marker :
J—h—HEEDON/OfftIWE R

VF Adjust:
Ea—774 Y45 —BEEOEZ T ALHH
L RILN—DERR

VF Mode:
Ea1—T7/4>5—BEEDHS—/E/
sOyIvER

Gamma Display Assist:
HITRRT A MEROYIVEZ

Peaking:
E—F > HEEDONn/OffgIWE X

Zebra:
YT SHEEDON/OffIUE X
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Project>Assignable Button Project>Assignable Dial
FYHAFTILIRY IADOEEERIY L TREREEITVET, FHAFTIIAVILADOHEEEIY YT, BEARAORELTVET,
AZa—-IEH MBLHREE RE AZa-IEH MBLHREE RE
<1> ~ <9>, Volume: Grip Dial Normal / Opposite Ty TTFHAFTILIALYILOEE AR
Focus Hold Ay RRVIFFB K URNERE R E— Direction ERET S,
Button H—DEZA-—BELRILZFHETS Normal : lEAMICEIERT 2
Thumbnail : Opposite : WEAMIC[EERT S
BLRAIVEEORE/ KT Handle Dial Off /1SO/Gain/El / ND Filter / IRIS /  \YRILFHAFFILIAVILIC#EEREIY
Touch Operation: N Auto Exposure Level / Audio Input LT3,
Ty FEREOON/OfFEIUER Level / Multi Function Dial ISO/Gain/El :
Handle Zoorp: TAVFIISEIHAMT S
INYRILX—-LEMEDEIVE R ND Filter:
NFC: _ NDZ7 LY —%REIT 3
NFCIERED E1T IRIS -
Auto Upload (Proxy): FAYREREH TS
7O+ 7 7L OBEEZEDON/Off Auto Exposure Level:
ovEz BB L AL AR T
Dlrec\t Menu: Audio Input Level:
ALY RAZ 21— DRAR/RRT BELALEREHTS
User Menu: Multi Function Dial :
UserA—a1—DRAR/HET VIFT7o02a>FA4vILELTH
Menu: 93
- — 72y
WA= a—ORiE/RT Handle Dial Normal / Opposite N RLFHAFTINIA VL OEGHE
Project>Assignable Dial Direction E/RET S,
FHAFTINIAVILADOKEEEIY YT, BEARORELTVET, Normal : lEAMICEIERT 2
A= 21— MBEREE NE Opposite : EAMICEERT S
Grip/ Off /1SO/Gain/El / ND Filter / IRIS / TV T PHAFTILIALVILICHBEEEY Project>Multi Function Dial
Remote Dial Auto Exposure Level / Audio Input LT3, TIF TP 3AVIALVILADKEEERIY Y TRERITVET,
Level / Multi Function Dial ISO/Gain/El: AX=a1—IEH MBLCBEE NE
ND gl'tfe\?.ifcliEl%Eﬁﬁﬁi'é Default Off / IRIS / 1SO/Gain/El / Auto TILFT72023a>FALVILDOF T4
. . H L gl b hY V4
NDZ 1 L& —% BETT 2 Function Exposure Level / Audio Input Level Tﬁ;@;’&:.] )Y T3,
IRIS: o
PAUREBEHT S P4 UZERMTS
Auto Exposure Level: 150/Gain/El:
= o1 s m JAVERISEIZFRETS
A daoiijﬁgﬂjtigjgl?ﬁﬁﬁ?% Auto Exposure Level:
B LA L5 EEIEHL AL AR S
M I‘ti FE ction D? % Audio Input Level:
ui runction Miar: BELAIVEBRETS

TILFT7292a>FA4vILELTH

F9%
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Project>User File
YT 7L OBRFICEATEIRELZITVET,

AZa—-1HH MBEEREE

RE

Load Execute / Cancel A—HY—T7AILDREECFexpress
Media(B) Type A/SDAH—RZOv h(B) ICEALK
AEY—H—Rh5HEHFAD,
Execute : 17
Save Execute / Cancel AT 7LD E % CFexpress
Media(B) Type A/SDAH—RZOv h(B) ICHALLK
AEY)—H—RIREFET S,
Execute : 17
File ID dA—HY—TJ7A)LDFile IDRIRETREETT
SHEHE%ZXRTNT B,
Load On / Off Load Media(B)DZE{THFICUserA=a1—
Customize DBRHRYI VA X EREFHFALMED
Data MA&ERET 3.
Load White On / Off Load Media(B)DZETERFIC/KRT A RS>
Data AEREFHACHESIHERET 3.

Project>All File
Al 7AILICET 2R EZITVET,

AZa—IRH HMBEEREE

RE

Load Execute / Cancel All7 7L EEGRIFHALD,

Media(B) Execute : 1T

Save Execute / Cancel A7 7ML RET S,

Media(B) Execute : 1T

File ID TP AILICRTZE T3,

Load On / Off Load Media(B)DZE{TEFIC. Network*
Network Za—-DREBFEREFRFHACNE >IN ZER
Data ETI 3.
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Paint/Look A= 1—

EAZ1-THHOWES LUREMERIUTOESY TT,

TimHER QYR EMEIZ. AXF(H):18dB) TRLET,

Paint/Look>Reset Paint Settings
HAILy IS DPaint/LookAZa1— DR EEE VLY RLET,

Paint/Look>Scene File
Scene7 7AILICBETBRBRELZITVWET,

AZa—-IHH MEEREE

AE

AZa-1H MBEHREME AE
Reset Execute / Cancel BRIy 7SN DPaint/Look A= 1—DE%

without Base
Look

EEDOUEY EETT S,
Execute : 17

Recall HWEAE —[CRETNTVBSceneT7 74 :
WEBHAD. BEOBHEECERTS. | s e et s
Store RECEHREREESceneT71ILEL — - . —
THEAEY—CRET 3. *=a1-RE MBLREE m&
Delete ABAEY —ICIREINTWBScene T 74 Master —99.0 ~ +99.0(%+0.0) YRYI=TIvILNIEZERETS.
ILEHIBRT B, Black
Preset Recall Shooting ModehiCustom@T, Target Tty NEE(EFRIRE) ZREOH R Black —99.0 ~ +99.0(+0.0) RISYILARILERET S,
DisplayAiSDR(BT.709)D&F HRECERTS. B Black —99.0 ~ +99.0(+0.0) BISvILARILERET 3.
S-Cinetone / Standard / Still /
ITU709 Paint/Look>Knee
Shooting ModehiCustomT. Target Z—WEDREETVET,
DisplayA"HDR(HLG)D & & AZa—-1BH MBEREE ES
HLG Live / HLG Natural Setting Target DisplayMSDR(BT.709)m & * Z—TEIE%EEE ONn/Off I3,
Paint/Look>Base Look on / Off / --- ]
W £ SR A LT : N
% —%igi;ém%ﬁagié&i;;ﬁb L AE Targoer’: /chs)[#a/y_ff\_HDR(HLG)d)t% Base Looki&R EdDSelecthiStandardx /=1
= ’ “ i ITUT09DEEDHENTT.
Select Shootlngﬂ ModepiCustom, Target EXLy 7 RBRT 5. Auto Knee  Target DisplayMSDR(BT.709)m & ¥ Z—hZ—H#8%0ONn/Off 73,
DisplayMSDR(BT.709)m & &
S-Cinetone / Standard / Still / On/Off /- e
ITU709 / User1 ~ User16 Targoet /Dg‘;;‘a/yb‘HDR(HLG)G) s
Shooting Mode#iCustomT. Target n . .
DisplayMHDR(HLG)D & & Point 75% ~109%(90%) ) 18 O N i
HLG Live / HLG Natural / Slope —99 ~+99(+0) ——20-7%RET 3.
User1 ~ User16
Shooting ModehiCine EI@ &F
709 / 709(800) / S-Log3 /
User1 ~ User16
Delete FIRUIEERILY I 5 HIBR T 3.
Delete All IRTOERILY I HHIBRT S,
Import EBRATATHESERILY T T 7L EGRH
AL,
Input S-Gamut3/SLog3 / Select TEIRLTWBERILYIDAA
S-Gamut3.Cine/SLog3 GamutZ&&/ET 3.
Output BT.709 / HLG Select GEIRL TV B ERILYIDHAE
HEHET S,
AE Level OEV /1/3EV/2/3EV/1EV / 4/3EV / Select C:EIRLTVWBERILY I DEHE
Offset 5/3EV / 2EV EEERET D,
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Paint/Look>Detail
T4 T—ILABDREETVET,

Paint/Look>Multi Matrix
VILFIRU I ZHEDHREETVET,

AZa-—18H MBEHREE AE AZa-1H MBEHREME nE
Setting On / Off T4 T—ILiEBERON/Off T3, Setting On / Off Multi MatrixfiE#8E% On/Off 33,
Level —7 ~+7(%0) FATF=ILLRILERET S, Reset Execute / Cancel KEoEOEHE(E1—) LEAMEYFa
Manual on / Off / --- F 15— L FEHBEMEERON/OF T 3, L—>3%) ZINTHIHECT 2.
Setting AXis B/B+/MG—/MG/MG+/R/R+/ Axis%&EIRT 3,
V/H Balance —2 ~+2(+0) F4F— L EBFEEECEE(V) /KTFE(H) YL=/YL/YL+/G=/G/ G+ /CY/
FAFLONFVRERETS. CY+/B—
B/W Typel/ Type2 / Type3 / Typed / Types 5«5 — L FBBERCTA(B) /LA(w)  Hue —99~+99(20) Multi Matrix@iEOX R LGS EOEH
Balance FAFLONTYRERET S, (Ea-) ZRET 2.
Limit 0~7 FAF— L EBFEECFAF—ILDOYSy Saturation —99 ~+99(+0) Multi MatrixfIEDQXI R &3 2EOEMNE
RLALERET S, (BFaL—>a>v) #BET3.
Crispening 0 ~7 FAT—ILFBRABECIITZVIL
NILVEBRET 3.
High Light 0~4 FATF-ILFEAREECRBERSOT ¢
Detail F=ILLRNILEERET B,

Paint/Look>Matrix
IR ZHEDREEITVET,

AZa—-IEH MBLHREE NE

User Matrix On / Off A—H—T MY X EHEERONn/Off g
%,

User Matrix —99 ~+99(+0) MESBOBORT(VFaL—>av) &

Level HET S,

User Matrix —99 ~+99(+0) MGEeEoeEaWNT7I—X) #FH¥T 3,

Phase

User Matrix —99 ~+99(+0) R-GHA—H—-TRJIREFERICRET

R-G %,

User Matrix —99 ~+99(+0) R-BOI—H—-TKNJIZREEFECHKRET

R-B 3.

User Matrix —99 ~+99(+0) G-ROA—H—-T M) I 2EFEBICRET

G-R 5.

User Matrix —99 ~+99(+0) G-BOA-—H -V RUIZEFERICHRET

G-B %,

User Matrix —99 ~+99(+0) B-ROA—Y—ZR)IZAFEICKRET

B-R %,

User Matrix —99 ~+99(+0) B-GOA—HY -V KNI ZEERICKRET

B-G %,
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TC/MediaAZ=Z1—

EAZ1-THHOWES LUREMERIUTOESY TT,

TimHER QYR EMEIZ. AXF(H):18dB) TRLET,

TC/Media>HDMI TC Out

HDMIFI DY A LD— R AT 2REZTVET,

TC/Media>Timecode
HSALTI—RDBREEITVWET,

AZa-1HH MBEEREE

S

AZa-IHH MBEEREE

AE

Setting On / Off

HDMIZFIAL T, tOEBAKSRCI A
LO—REHATEIDNESHZRET S,

Mode Preset / Regen / Clock

GALI—ROSEE-RERET 3.
Preset(Z’Utwhk) :
BREINEHNSHHET S,
Regen(UTzX) :
ROy TDYALD—RICEKITTSES
T3,
Clock(#Ow%) :
NERStEY A LO—RELTHERT
5.

TC/Media>Clip Name Format
Iy TOLMPHIBRICETZREEITVET,

AZa-1HH MBEREE

S

Run Rec Run / Free Run

Rec Run: iCEREDH ST 3,
Free Run : SeRICEFRLELEICHHET S,

Setting

YALI—RZERDEICRET S,
SET:RE

Reset Execute / Cancel

44 L31—K#%00:00:00:001CUtw kT
N
Execute : 17

TC Format DF / NDF

HAALI—RDT#—T v NERET B,
DF: ROvZ7L—LA
NDF: />ROvZIL—A4

TC/Media>TC Display
YALT —IRTDHFELITVET,

AZa-IHE MBEREE

mE

Display Timecode / Users Bit / Duration

Select

GALT—IDRTZTNIEZS,

TC/Media>Users Bit
A—HY-EvhcEIZREEITVET,

AZa-IHH MEEREE

RE

Mode Fix / Time

A—HY—-EvrDE—REZRET 3.

Fix: a—H—EyMNEBEOEEE:ER
g3,

Time: 1—Y—EvNCREORK M & F
Bd3,

Setting

A—Y-EyvrEERDEICRETS.

Title Prefix  nnn_(nnnlgZ> U 7ILES DO T3H7)
(BRRTXFERT)

)y TADI A MLED (4 ~ A6XF) &
RET 3.
XFIDODANBEEZFUHT.

XFHDOASNEEDIERK

XFEIRT7(317) :
Title Prefix TU 7 DA —VILNIECHF
ATBIXFEFEIRT S,
1#$%()+.-.;=@[ ]*_~0123456789
abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVW
XYZ

H—=VILRET) 7(147) :
Space: H—VILIEILAR—-IZHEA
EE-R
— H=VILEEICRETS,
— h—=VILEGILEET S,
BS: h—VILAIEDEDXFZHIFRT
%,

Title PrefixTU7(117) :
FANLEANTZIVT,

A RNILEERETBICIE

1. QILFELIY— (IR=-) &fF>
T. XFEIRT) 7 H5Title PrefixT
TP DH—YVILIEIC ANBXF %8R
(1S54 bERTR) L. YILFELIY—
DRTERY VEHT, (BRLEXEN
AW, B=VILHEICBEITS.,)

2. FIE1EZEYERL. Y1 NLERET S,
(BRERRLT, BSEERT3,)

3. 914 NILADRENED /5, Done
EFEIRLTCXEINOAHEEEFHL 3.
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68 AZa1—FRREFHMERE TC/MediaXZa—

TC/Media>Clip Name Format
Iy T OLMPHIBRICET 3R EEITTVET,

AZa-IEH MBEEREE

RE

Number Set 0001 ~ 9999

)y TROBREDESED (4HT) ZRE
EE:H

TC/Media>Update Media
AEU—H—RNAOEBI7IIILEEHFLET,

AZa—I8H HMEELHERE NE
Media(A) Execute / Cancel 20vMADAEY—H—RROEET 741
IWEEFHTS,

Execute : 17

Media(B) Execute / Cancel

Z20Y RBOAEU—H—RROEET 74
ILEBHT S,
Execute : T

TC/Media>Format Media
AE—H—RZHHALLE T,

AZa-IHH MEEREE

RE

Media(A) Full Format / Quick Format / Cancel

20v RADAE) —H—REHHRLT S,

Media(B) Full Format / Quick Format / Cancel

Z20v rBOAEU—H—REHH{T 3,
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MonitoringA—1—

BAZ21-EEOMES LUREBEIATOESYTT, Monitoring=>Display On/Off
TIZHERFOYHAR EMEE. AXF(HI:18dB) TRLF T, BEEEREEOREEITVET,
AZa-IEH MBELHREE NE
Monitoring>Output On/Off " ; =
BRI A DR EETNET Network On / Off Ea—J7( Y5 —HEAICRTT3EE%
_ > Status BIRT 3,
AZa—-IFH MBEHREE NE ;
File Transfer On / Off
SDI On / Off SDI#%0n/0ff g3, Status
HDMI On / Off HDMIti 4% On/0Off ¥ 3, Rec/Play On / Off
Monitoring>Output Format Status
HAT4—IvRDREETVET, RAW Output On / Off
A=a1-1BE MEEREME nE gontm'
tatus
SDI HREEBEHICOWTFHLLIE, THADT4+—  SDIEHDMIEADRRERERT 3. Tall on 7 Off
HOMI | Ry hEHIBR) (M9R—) £ZH KT aly L
W, Battery On / Off
Monitori Output Displ Remain
onitoring>Output Display
BEETOUARERTVET, Focus Mode On / Off
*=2-1E MECREE RE Focus On /Off
Position
SDI On / Off SDIHAEETADAZ 3—PRF—9 XK
. — i F A On / Off
L. BEETOERERETS. e =
HDMI On / Off HDMIEAEEADAZ 3 —PIXF—4
o — o . Zrie Focus Area On / Off
Face/Eye On / Off
Detection
Frame

Lens Info On / Off

Imager Scan On / Off
Mode

Rec Format On / Off
Frame Rate On / Off

Zoom On / Off
Position

UWP RF On / Off
Level

SteadyShot On / Off

Base Look/ On/ Off
LUT

SDI/HDMI On / Off
Rec Control
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Monitoring>Display On/Off
BEERXNEEOREZITVET,

Monitoring>Marker
N—H—RROBREZEITVET,

AZa—-IEH MELHREE NE AZa—-IEH MELEEE NE

Gamma On / Off Setting On / Off TRTDIY—H—KT%EFELHTON/Off T

Display %,

Assist Color White / Yellow / Cyan / Green / J—h—DESEEEIRTS,

Proxy Status On / Off Magenta / Red / Blue

Base ISO/ On / Off Center 1/2/73/74/0ff oy —T—h—%EIRT 3.

Sensitivity Marker

Media On / Off Safety Zone On / Off 774V —-2TY—Hh—%0n/0OffF3,

Status Safety Area 80% / 90% / 92.5% / 95% T—T7F4—V—UT—h—DOkFT(EE

Video Signal Off / Waveform / Vector / Histogram BRICH T BHER) 5#IRT S,

Monitor Aspect Line / Mask / Off FARYT NI—H—DrEEIRT 3,

Clip Name  On/ Off Marker

White On / Off Aspect 0 ~15(12) J—h—NMUDEFFESDLARILEZERTE

Balance Mask EESR

Scene File  On/ Off Aspect On / Off FARGNE—TF—V—7T—h—%

Focus On / Off Safety Zone On/0ff9 3.

Indicator Aspect 80% / 90% / 92.5% / 95% FARGNE—TF4 =V =27 —H—DK

Auto On / Off Safety Area FT(EBRECKTILE) £:EIRT S,

Exposure Aspect 11/4:3/13:9/14:9/15:9/16:9/ FPARIINI—H—HRRTBZEFDE—R

Mode Select 17:9/1.66:1/1.85:1/2.35:1/ 2.39:1/ HRET S,

Auto On / Off Custom

Exposure Custom FREOERA$T3(01.00:01.00) FART N EEROEICERET 2.

Level Aspect (8]

Timecode On / Off Ratio Aspect SelecttCustom%zRIRLIZHZEIC.

ND Filter On / Off DERENEHMICAYET,

Iris On / Off Guide On / Off HARTL—LERREOn/Off T3,

ISO/Gain/El  On / Off Frame

Shutter On / Off 100% On / Off 100%<V—Hh—%0n/0ff 93,

Level Gauge On/ Off Marker —— —

Audio Level _On/ OFf User Box On / Off A—HY =Ry I AI—H—DFERREON/Off

Meter User Bo 3 ~ 479(240) i%:f Ry I ZAI—h—OE(FLMSE
. X ~ — U=y —7]— =1 ]

:,’\;jfr?irfsve' On / Off Width Al TOER) ARET 3.

Clip Number On 7 Off User Box 3 ~269(135) 1—1{:—rﬁw’77;7—73—0)%_1"(¢lﬂ\73\5

: Height IRimETORER) 2RET S,
Rlnc:sf:ge On 7 Off UserBoxH  —476 ~ +476(0) 21— =Ry J 27— H— O OKFAL
Position BERET S,
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Monitoring>Marker
N—h—RTOREEITVET,

AZa-IHH MBEEREE

RE

UserBoxV  —266 ~ +266(0)
Position

1= Ry I 27— H—ORLOEBL
BARET .

Monitoring>VF Setting
Ea—T7/4 25 —DREETVET.

AZa1-1RH MBEREE

AE

Brightness 1~ 15(8)

E1—T74 V9 —RIGOAZ T ERFET
3.

Color Mode Color / B&W

E-ERR/EBROEI—T 7109 —-DF
TE—RERERT S,

Monitoring>Gamma Display Assist
HIIRRTIANDREEITVET,

AZa-1HH MBEEREE

RE

Setting On / Off

CustomE— K TTarget Displayh
HDR(HLG)E D H > TRRT7 2 Mikes
On/0Off¥ 3,

Monitoring>Peaking
E—F2JDREETVET

AZa-IHH MBEEREE

RE

Setting On / Off E—F>J#EERON/Off T3,

Peaking High / Mid / Low Ho—E—F2IDESLARILERET S,
Level

Color B&W / Red / Yellow / Blue HS—E—F2IDEFEEREIRT S,

Monitoring>Zebra
IS/ DEREETVET,

AZa-1HH MBEEREE

RE

Setting Off / Zebral / Zebra2

TISRROBHE(OM, €731, €752)
=BIRT 3,

Zebral Level 0% ~ 109%(70%)

CTISNERTTELANILERET S,

Zebral 2% ~20%(10%) CTIS1DOTFNR—F v —LRILERET 3.
Aperture

Level

Zebra2 0% ~ 109%(100%) TIS2BRRTBLANILERET S,

Level
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AudioA_—a1—

BAZ1-—EEDOHRES LUREEEIUTOESYTTY,
TIZH AR OFIHAR EMEE. AXF(H:18dB) TRLET,
rJOvo894v45S01 (134R—=3) #HETIBE<LEYT

LY,

Audio>Audio Input

Audio>Audio Input

BEANDEREETVET,
AZa—IEH MELHREE AE
CH1 Input INPUT1/ Internal MIC / Shoe CH1 SEECHICN T2 ANTEYIVER S,
Select
CH2Input  INPUT1/INPUT2/ Internal MIC / Shoe ESE8CH2ICHTBANTEYIVEZ S,
Select CH2
CH3 Input  Off / INPUT1 / Internal MIC / Shoe CH1 E#CH3ICHTB3ANTEYIVEZ 3,
Select
CH4 Input Off / INPUT1/ INPUT2 / Internal MIC / SEEECHAICHITZANTEYTIVEZ S,
Select Shoe CH2
INPUTTMIC —80dB/ —70dB/ —60dB/ —50dB/ INPUTIHOSDXLRIYAIAAICXTE TS
Reference  —40dB/ —30dB TPLYZLRNILERET 3.
INPUT2 MIC —80dB/ —70dB/ —60dB/ —50dB/ INPUT2HSDXLRYAIAAICKTSB)
Reference  —40dB/ —30dB T7LYALRILERET 3.
Line Input +4dB 7/ 0dB / —3dB / EBUL INPUT1/INPUT2 21y F DEREMLINED
Reference FEDEEANLANILEEIRT S,
Reference  —20dB /—18dB / —16dB / —12dB / HEAALARILDIKHZIEEEDZELANIL
Level EBUL wERT S,
CH1 Wind On / Off SEEECHICH T 2REEB T 1ILY — %]
Filter b
CH2 Wind On / Off FCERCH2ICX T BRAFER 7Y —%5%
Filter b
CH3 Wind On / Off SCERCH3 I T2 RAFER 7 1ILY —%5%
Filter ET 3,
CH4 Wind  On/ Off SRCHAICKH T ZREEER T 1ILY —% 5
Filter b
CH3 Level  Auto / Manual EBRCHIDBEFAALRILABRZEEICT
Control 2h. FEICTZIN%ERET 3.

[ZEE]

CH3 Input Select. CH4 Input SelecthiEE5
Hinternal MICIZERE TN TV RIHEF. ANGF
EIEEHLTCHADBE - FEbIUBDYET,

EEANOEREEITVWET,

AZa-1H MBEHREME AE

CH4 Level Auto / Manual SLERCHADBEANLANILGAREABHEICT

Control 2h. FEICTZHN%ERET 3.
[TFE]
CH3 Input Select, CH4 Input SelecthEs5
Hinternal MICIZEREINTWVWSHE X, CH3
Level Control DR EICEEFLTCHADBEE) - F
BFEUUEDYET,

CH3 Input 0~ 99(@) SCERCHIDAALARNILEZRET S,

Level

CH4 Input 0~ 99(@) SRCHADA AL RNILERET B,

Level

Audio Input 0~ 99 EEAALRNILERETS.

Level CH1 Level ~ CH4 Level DR EICREST.
J2Y—Ra—LELTHERTEEY,

Limiter Off / —6dB/ —9dB/ —12dB / —15dB / F—F A ZAALRNILOFHAGHHOLE

Mode —17dB BESICHTEZIIvY 4545 EIRT S,

CH1&2 AGC Mono / Stereo SCERCHIEEERCH2OEF L ANIILARE—

Mode R&ERETS, StereolcFEINTVNBE
T, CHEITAGCHEENT B,

CH3&4 AGC Mono / Stereo SLERCHIEERRCHADOBFLANILAEE—

Mode R&EERET S, StereolcfREINTWVWBE
F(F. CHRETAGCHEHHT B,

AGCSpec ~ —6dB/ —9dB/ —12dB/ —15dB / AGCH 1% BIRT 3.,

—17dB

1kHz Tone  On / Off HI—N—RTHD1 kHzDEEFHES

on Color %#0n/0ff93,

Bars

[TEE]

OnlcE&EI S &. CH3 Input Select. CH4
Input SelecthOFfDIZETE. 1kHzOEHES
FES%CRCH3, BBCHAICELET,
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Audio>Audio Input

Audio>Audio Output

BEANDEREETVET, BEEHADEREETVET,
AZa—-IEH MELHREE AE AZa—-IEH MELEEE nE
CH1 Level XLR74 749 —AAH%L SERCHIOBBRAALANILAROESFED Monitor CH CH1/CH2 / CH3/CH4 / MIXALL/ CH1/ AYRKRVIHEFEIURBEIE—D—(CH
Audio Input Level / Side / TERET S, CH2 / CH3 / CH4 HIBEEFvUXILEERTS,
Level+Side i i
XLRWj]@L)(SO/\O—\\/“) [&.II:@J [L/I;%'x]
Audio Inout Level / Through Side[IA&RIENAUDIO LEVEL(CHT) 91+ BEFroXIILOEREREE AT 2R EESE
P 9 LEELET, Level+Sidex e Lic L+ BRUESEE. BHNLAVESCEF o2
Audio Input LevelEREDEIG LY VILERED LOEALANIILERFCEENEATNET,
EEEHTEDLERFEHBRELANILCHEYET Volume 0~50 AYRRVIBFESLURBIE—H—DE
(134x=2). —H—BELNILEFET S,
CH2 Level XLR79 T9—AAML LRCHZOBFAALNLAROBHED Headphone Mono / Stereo Ay RRVIEF%E/ ZI)L(Mono) BAIC
Audio Input Level / Side / BERET 2. Out o T3, ZFLA(Stereo) HAILTZME
Level+Side :
— ‘ [TE] BiRT B,
XLR74 74 — Y(50R— -
) 9.7?9 ANB(50X—2) Side A %EIEDAUDIO LEVEL(CH2) 1+ Alarm Level 0 ~7(4) EEBOBEANART S,
Audio Input Level / Through e . snes 4opo =
i\“z?ﬁIW?“;LLEVT;EZEZQ&E;L%;:;*% HDMI CH1/CH2 / CH3/CH4 HDMIIZH AT NBEEF v RILOMEH
udio Input LevelaEO=m R Output CH BhEERET S,
ZEEHFEDOEIEEEIBRELAILICKEYET P = HET
(134R—-2),
CH3Level  XLRP4 F9—AA%KL ERCHIDBEFAALALBEOMHE
Audio Input Level / CH3 Input DLEERET S,
Level / Level+CH3 Input Level
XLR74 T5—AHh&W(50R—)
Audio Input Level / Through
CH4 Level  XLR7H F9—-AH%L KBRCHADBFEANLANIILFAZOEHE

Audio Input Level / CH4 Input
Level / Level+CH4 Input Level

XLR74 79 —AHd4W(50R—2)
Audio Input Level / Through

bEERET S,
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68 AZa—FRNEFHFMERE

ThumbnallAZ 31—

BEAZI-THEOWES S UREBRIUATOLESYTY.
TR QYRR EMET. AXF(f:18dB) TRLET,

Thumbnail>Transfer Clip
gy T HERERLET,

[ZFE]
Network X = a—®mAccess Authentication /N 27— R Z 5 ELTVWEWES. Transfer ClipldERETETFE A,
—a1-IRH MBEREE RE
All Clips Iy ThE—EERXT 3,
[ZEE]

X TE37 Uy TOLERIZ2004 T,

Thumbnail>Transfer Clip (Proxy)
IO+ 7y T RERELET,

[TEE]
Network A= a1—®Access AuthenticationT/V 27— R&ERELTWAWES. Transfer Clip (Proxy)Zi&E T
FFEHA.
AZa—-IEH MELEEE nE
Select Clip FROIVyFICHISLTWE IO+
Jy T HEE*ET S,
All Clips Iy FICRIS TR 7OF 7 )y TE—

BEXT 3,

[TEE]
EXTE37)yTOLERIZ2004TT,

Thumbnail
AZa—-IEH MBEHREE NE
Display Clip Iy FEMEREmEERL,
Properties
Thumbnail>Set Clip Flag
IV T ISTDREETVET,
AZa-IEH MELHREE NE
Add OK OKZ7 57 &AF1+3.,
Add NG NGT SV %&fF1+3,
Add KEEP Keep7 345 % {1133,
Delete Clip ITRTDT ST %HT,
Flag
Thumbnail>Lock/Unlock Clip
Iy TORERTERTVET,
AZa—IEH MELHREE NE
Select Clip RE&/REMIRTB U Uy TEBRLTE
795,
Lock All ITRTDI )y THRET S,
Clips
Unlock All ITRTOI )y TR ARERRT S,
Clips

Thumbnail>Filter Clips
ENTBIVYTOREETVET,

Thumbnail>Delete Clip
Iy THHEIBRLET,

AZa-IHH MBEEREE RE

Select Clip FE0V) v TEHIRT S,

All Clips )y THE—IEYIBRT 3.

Thumbnail>Transfer Clip
Iy THERERLET,

AZa-IEH MELEREE AE

OK OKZSH DD\ )y TDHERRT S,

NG NGTZ ST DD\ )wTDHERRT B,

KEEP Keep7 557 DDW)wTDHERRT
%,

None TSTDDODVTVWIEWI Uy TDH%ERR
EE-D

All IS5 DHBYIELICLET. TRTDI Uy

TERRT S,

Thumbnail>Customize View
HLAXAEEORTEYIVEZ XY,

[TxE]

Network X = a—®Access AuthenticationT/N\ 2T —RZF&E LTWREWEE. Transfer Clipl&RETT £ HA.
AZa-1HH MBELREE N
Select Clip FEOV) Y THEIKXT B,

AZa-1EH MBEEREE

S

Date Time / Time Code / Duration /
Sequential Number

Thumbnail
Caption

YLXABEETORTABRZTVER
3,
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Technical A= a1—

EAZ 1 -THHOWES SUREBRIUTOESYTY,

TimHER QYR EMEIZ. AXF(H):18dB) TRLET,

Technical>Touch Operation
Ty FRIEICETZRELEITVET.

Technical>Color Bars
HS—N—DREETVET,

AZa-1HH MBEEREE

AE

Setting On / Off

HS5—/\—%O0n/OffF 3,

Type ARIB 7 100% / 75% / SMPTE

HI—-N—DOEFZRERT B,

Technical>ND Dial
ND VARIABLES A V)L DRIEICBE T 2R EAITVWET,

AZa-IHH MBEEREE

RE

CLEAR with  On / Off
Dial

ND VARIABLEY 1 V)L DIEFETNDDIK
BB (CLEARSON) ZFJREICTZHES
MRET 3.

AZa-1H MBEHREME AE
Setting On / Off Sy FEEEON/OffT 3,
Technical>Rec Review
Ly LE1—DREEITVET,
AZa-—1H MBEHREME AE
Setting 3s/10s/ Clip LysLEa—CERIICERLEIVY T %
BYE T A EIRT 3.
Technical>Zoom
A—LDFREETVET,
AZa—-1HE HMBEHRERE AR

Technical>Tally
/IS TOREEITVET,

AZa-1HH MBEEREE

RE

Front On / Off

sCiR/49')—5>F(Front) 20n/0ff3 3,

Rear On / Off

sC8R/49')—S5>F(Rear) #0n/0ff 33,

Optical Zoom Only / On(Clear Image
Zoom)

Zoom Type

ZA—-LOBHEERET 3.

Optical Zoom Only:
LYZX&EEMT I EICLY . HFERAL
A—=L%1T>

On(Clear Image Zoom):
EEHEADEV, BEFHNLEI-L%
15

Technical>HOLD Switch Setting
R=ILRZA Y FOREEITVET,

Technical>Handle Zoom
INYRILZ—LDOBREEITVWET,

AZa—-IFH HMBEEREE

RE

AZa-THH MBEEREE

S

with Rec On / Off ERESTART/STOPHRY > & K—ILR DR
Button ICTBHIERRICTEINERET S,
with Hand  On / Off JUyFTVEIVICEZBERER—ILRORE
Grip Remote RICTIDIERRICTEINERET S,
Handle Normal / Rec Button Only J\YRJLHOLDZA v FDR—ILR5FR%E /\
HOLD > RILEREBISTART/STOPRY U TEFICBRTE
Switch TEINERET S,
Normal:
INY RILERD IR TOIRVEE M & 7R —
ILRMRICT S,

fefzLe I\NY RILERESTART/STOPR
4 > IFwith Rec Button®sRE [CREL
¥,

Rec Button Only:
I\ RLERBESTART/STOPRY > 1+
ZR—ILRWRICT S,

Setting Off / Low / High / Variable INYRILZA—LRAE—REHRET S,

High 1~8(8) I\YRILZ—LZAE—RHigh#EiRE, /\>
RILZ—=LLN=ZRLIcEETDX—-LR
E—REHRET 3.

Low 1~8(3) NV RILZ—LZE—RLowsEiREE, /\UR

WZA=LLN=%RLIcEETDX-LAE—-
RZ2RETS.

[TE=]

A—LZE—RMERDEFICA-I VT ICL5
NHBZENBYET,

Technical>Menu Settings
AZa1— T BREZITVET,

AZa-1HH MBEEREE

S

User Menu On/ Off

Only

AZa—ARRLIEEFIC, UserAZa—
EHERRTZHO0ON), AZa1—UXL%E
XRRTBM(Off) 2R/ET 3.
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Technical>Menu Settings
AZa—(CBATRRELTVET.

Technical>Fan Control
TP UHIHME—-ROREETVET,

AZa-IEH MBEHREE NE AZa-IEH MBELHREE NE
User Menu On/ Off AZa—FRRCOvIEMIFT, Useri Setting Auto / Minimum / Off in Rec AEOT7UHIHE—RERET 2.
with Lock Za-RHORRCTEINESIHERET (]

%,

(23]

BEHOAZ 1—FRRBETERRINEEA, 4
Za—REROBEREIF. TAR—IETEL
ZEV,

Off in Rec&EFIRLTVWTEH. AEORERRE
N—EBE£2BZ3ET77UNEELET,

Technical>Lens
LY XA 3BREETVET,

Technical>Menu Page On/Off
2T =Y ABHEDRRICEATIREZITVET,

AZa-IHH MEEREE

RE

Main On / Off AA VAT =Y ABEEDERRZEON/OffF
5.

Camera On / Off AASZT—4 ABEEDERT%ZEON/Off T
%,

Audio On / Off A—F4 A AT —9 ABEEDOERRZON/
Ooff9 3,

Project On / Off OV MR TF—9 ZEENETR%Z0n/

Offg3,

Monitoring On / Off

EZYIUVIRT—F AEEDOERTREZON/
offg3,

Assignable  On / Off

FHAFTIARY V2T -4 ABEEDERT

AZa-IEH HMBELEERE AE
Zoom Ring  Left(W)/Right(T) / Right(W)/Left(T) A=KV DBRIEFARZRET 2,
Direction R
[L7$,§»J
Z—=LY) YT OBREARTYEZICHIELIEY
YN ERBOHRETTET,
Shading Auto / Off BERELAXEMEZRET S,
Compensation
Chroma Auto / Off HEERENEMEZRET S,
Aberration
Comp.
Distortion  Auto / Off HEEHNEMEERET 3,
Comp.
Breathing Auto / Off LYZDT )V HIERRET 3.

Compensation

Distance Meter / Feet LYXERET+—HZRI T a>OFRR
Display B #HRTET S,

Zoom Focal Length / Number / Bar A—LIBORTEAZRET 3.
Position

Display

Button Z#0n/0ff9 3,

Battery On / Off Ny F)—2F -9 ZBEEDERRZON/
Off9 3,

Media On / Off AT« TP AT —4 ZBEDER%On/Off
EE-R

Network On / Off XY RD—=J2F—9 ZEEDERTZON/

Offg3,

File Transfer On / Off

TPAIIVEREZT — 9 ABEDERRZON/
off¥3,
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Technical>Video Light Set

EFZ 5/ hORITARERELET, HVL-LBPC(RIE) ERROHEMHRETT.

AZa-IEH MBEEREE

RE

Video Light Power Link / Rec Link / Rec Link + Stby
Set

IIWFAUY—=T 1= a—CBYWHFIT3
ETATANDORITARERET 3.
Power Link:
AEOEFROAN/IEEBILTET A S
A MDRAT/EIT 3,
Rec Link:
A OREBB/ R TIEFHLTET
54 MRUT/EITT 3,
Rec Link + Stby :
A OFEBIB/RTIEHLTEST
FZ4 MR/ ZY VINALRIT T %,

Technical>APR

APREZETLET.
AZa-—1H MBELHREE AE
APR Execute / Cancel APR(Auto Pixel Restoration : £ A—<

oY —0BEAE) XT3,
Execute : 17
[ZFRE]

ETHCBLTLYXF vy TEEELTRETV,

Technical>Camera Battery Alarm
Ny F—DEEBETEEDREEZITVET,

AZa-IHH MEEREE

S

Low Battery 5% /10% /15% / .../ 45% / 50%

Ny T—BRERTEEERTIS%RESE
RETB(%ZIH).

Battery 3% ~ 7%
Empty

Ny FTU—YNELEZRTTE%ER
EE:E

%
fit

Technical>Camera DC IN Alarm
ANBEELSEDOREETVET,

AZa-IHH MBEEREE

RE

DCINANDAHNEEDETEEZRTT S
BEZRET S,

DC Low 16.0V ~ 19.0V(16.5V)
Voltagel
DC Low 15.5V ~ 18.5V

Voltage2

DCINADANBED AR EE#ZFT 3
BEARETS.
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Network A= 1—

EAZ1-THHOWES LUREMERIUTOESY TT,
TimHER QYR EMEIZ. AXF(H):18dB) TRLET,

Network>AP Mode Settings
FIEARA VN E—RTORBRICRTEIREEZITVET,

Network>Access Authentication
PO G RARECEATRHREETVET,

AZa-1HH MBEEREE

AE

User Name POCARADHDI—H—Z%EH/TET
%,

Input FICRBADIHDINAT—RAERET

Password 5.

[TEE]

TFa)FAOBERIMS. KXT—RICEAIC
HATNEELLFTALBRTOEIXFINERTE
L. BEICFETZIEEHRLET,

Generate Execute / Cancel

T CAFADH DN AT -2 BEE

AZa-1H MBEHREME AE

Channel Auto(5GHz) / Auto / CH1/ CH2/ CH3/ TAVYLIALANDF v XILERET 3.
CH4 /CH5/CH6/CH7/CH8/CH9/
CH10 / CHNM

Camera SSID AEEDSSIDE/XRT—RERTRT B,

& Password

Regenerate Execute / Cancel NKAT—RZBERT 3.

Password Execute : 17

IP Address KEOTI R4V N E—RTDIP7RL

2 RN B,
Subnet EKEOTIEARAVNE—RTOYT
Mask RYRIRTERTT 3.

Password mI3.

Execute : 17
Show PO ZERIAODIA—Y—-Z, IXXT—K,
Settings TaVH=TIV FEEORRA, 2V

PILESEXFEQRI-NTERTRT 3.

[TE=E]
NRT—REZHRSNTY,. QRO—ROEK
ERETERAVESICERELTEST W,

Network>Wireless LAN
JDAVLALANER CEATZREETVET,

AZa-IHH MEEREE

AE

Setting Access Point Mode / Station Mode /
Off

T4V LZLANEROEFE— R ERIRT
%,

WPS Execute / Cancel

WPS(Wi-Fi Protected Setup) Ic &3
G ERFIAT 3.
Execute : 1T

NFC Execute / Cancel

NFC(Near Field Communication) (2 &
BIERRTEXRBTS.
Execute : 17

MAC
Address

AEDOT AV LZLANA Y —T1—2D
MACPZRLZ%XRT 3,
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6% AZa1—RNEFMETE  NetworkAZa—

Network>ST Mode Settings

RT—Y3aVE-—RTOERICEATEIRELITVET.

Network>ST Mode Settings

AT—Y3VE-RTCOERICETEIREEITVET,

AZa-IEH MBEEREE

RE

AZa-1HH MBEEREE

S

Camera Enable / Disable 2TF—=2avE—-—RTAHEEDAVLR

Remote LANEHINTVWBTF/\A/1 I 5D)E—

Control RO RO—-IAEFRITEIMNESIHERTE
I3,

Connected BHEPOTAVYLALANXY NT—2(79

Network TZRA VK BRRT B,

SSID

BT LKAV N DSSIDERTT
%

Security

BRET7IEIARA Y OEFaVTATE
AEXRTT S,

Password

BRETIEIARA RO AT—RER
=93,

T a) T4 DWEP/WPABRS ; #¥+xr**
tF+a)F 1 HNonehF : 224

DHCP

DHCPOEH(On). #&N(0ff) £&RTI 3.

IP Address

DHCPAOffD & FICAWDIPT RLRE R
=Y 3,

Subnet Mask

DHCPAOFfDEFICABDY TRy AT R
VERRT B,

Gateway DHCPHOffDEEFICABED T I 4L —
oA %FRRT S,
DNS Auto DNSEENEFDON/OFF& XY 3,

Primary DNS Server

DNS AutoMOffQ EF ICAD TS5 1<
I)— DNSH—/\—%KRTT 3,

Scan
Networks

TAVLZALANRY D —0(FPU RS
VR &ZREL, YRAMERTT 3.
UZ Sk EERL. BRI 5.

SSID BT RA > hDOSSIDEERRT
%,

Security BRAETIVERRAVbOEFaUTo1E
AERTT S,

Password BHRAETIVEARAVMDIIT—REA
NI3,

DHCP DHCPOEZN(ON). |3 (Off) 2E/ET 3.

On / Off
IP Address DHCPHAOffO & FICAMDIPFT KL% A

EES

Subnet Mask

DHCPHOOFfO & FCAEDY TRy AT R
DEANT B,

Gateway DHCPMOffOEFICAED T T AL N —
ROTAZANT S,
DNS Auto DNSEEES % 0n/0ff 33,
On / Off

Primary DNS Server

DNS AutoMOff@ & FICABD TS 17
1)— DNSH—N—%AHT 3,

Secondary DNS Server

DNS AutoMOffo & FIcAEDEHV S
IJ— DNSH—/N\—%AHT 3,

Secondary DNS Server

DNS AutoMOffQ & FICAEDEH> S
')— DNSH—/\—% KT 3,




106 | 6B AZa—FRRNEFMERTE  NetworkAZa—

Network>ST Mode Settings
2ATF—Y3aVE—RTOERKICEATIRELITVET.

Network>Wired LAN
ERLANESICRE T 3R EAITVE,

AZa-15H MBEELHREE RE AZa-15H MBLHEE RE
Manual TFIEIARA VY NEFBNIERT B, Setting On / Off BHELANZON/Offg 3,
Register SSID BTV EZARA U RDSSIDEAAT Camera Enable / Disable AREFRLANBERINTVWST/NI D
3. Remote S5OUE—NIVNO—-ILEFATEINED
Security BRETVIEIRIVNOEFIUTAE Control h&RET S,
None / WEP / WPA AERET S, BHRETIEARIVED Detail BERLANEROFMBREEITD.
tFa1) T BRINWPAZZIZWPA2D15 Settings DHCP DHCP®BEZH(On) . |H(OFf) £BET 3.
ald. WPA%ZEIR, On / Off
Password BRET 7L ARA Y b ONRT—REA IP Address DHCPAOFfD & [CAMDIPT KL% A
ZERE EED
DHCP DHCPOEZN(ON). |3N(Off) 2_ET 3. Subnet Mask DHCPAOFfD & X IcAEDH T 2w hTZ
On / Off VEANT 3,
IP Address DHCPHOIOFf D &L EICAEDIPT RLZZEA Gateway DHCPAOFfDEFICTTAILND Y —
N3, HIAEANT 2,
Subnet Mask DHCPAOFf D& FICABDY TRy~ X DNS Auto DNSE#EE%On/Off 3.
IHEANT S, On / Off
Gateway DHCPAOff D EF LT T AL b D7 —b Primary DNS Server DNS AutomROffD & X IZF 547 —
VIAEANT B, DNSH—/N\—%AHT 3,
DNS Auto DNSEEEFZ0n/0ff 3, Secondary DNS Server DNS AutohoffoeEicth >4 —
On / Off DNSH—N—%ANT 3,
Primary DNS Server DNS AutomMOffoEEIc 7547 —
Network>Modem

DNSH—I—%AHT 3,

Secondary DNS Server

DNS AutoOffo&Elctthrd 1) —
DNSH—N\—%AHT 3B,

USBTH UV DEAICETZREETVET.

AZa-1HH MBEEREE

S

Setting On / Off AZ— T AV EROBERN(ON). FERH(OFT)
ERET S,

Camera Enable / Disable 27—k 7#>7F1)TdHBCBM(Content

Remote Browser Mobile) ¥C3 Portal App7E

Control g, USBFH ) v BATOUE—~TY
RO—ILOEEERET 2.

Device 27— K7 #>DDevice Namex X<

Name %,

IP Address AI—RI7AVDIPPRLRERRT S,

Subnet AI—KTAYDY TR NIRRT ERRT

Mask %
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Network>File Transfer
T7AILDEXRICREATZREEITVET,

Network>File Transfer
T 7ML DEEICEATZRERITVET,

AZa-IEH MBEEREE

RE

AZa-1HH MBEEREE

S

Auto Upload On / Off

7O+ 77 ILOBEEEXEON/Off T

(Proxy) 3.

Default TPAIINDERGE Y —N—%8RT3, <

Upload CCERLLEY—N—(F., 7OF>T74

Server ILOBEERRE. SLUYLXAILEED
SQOTFAIERFEDOH —/I\—IC3,
Server Settings 1 ~ 3T&&E L/zDisplay
NameA&RT 3.

Clear Execute / Cancel EXT T HEFOTITEIINE )T

Completed g3,

Jobs Execute : 17

Clear All Execute / Cancel IARTOERYITHEIINNSIUTT

Jobs %
Execute : £17

View Job %Xy 3J—BAXRT 3,

List

Server Display Name BRAEREDAZ1—LORTREEANT
Settings1 %
Service H—N—-DEHEERTT 3.
FTP
Host Name R —N—DRANEERET B,
Port(1 ~ 65535(21)) ERAEY—N—DR— N BESERET 3.
User Name BXREY-—N\—EROXRARI-—T 4%
HET .
Password IR Y — /NP /\ AT — R &5

EY 3.

Passive Mode
On / Off

PASVE—K%On/Off ¥ 3,

Destination Directory

BEEDTALIN)—ZZANT B,

Using Secure Protocol
On / Off

T+ a1 7RFTPERX(FTPSDEXplicit
Mode : FTPES) Z175H(0n). 1Th7ix\
W(Off) #ERET 3.

Root Certificate
Load / Clear / None

TFaPLFTPERETH D)L — MEIAED
Fidrhdr. HIBFZRET 2.

Root Certificate Status
Loaded / No Certificate

TFaTRFTPEXHDIL— NEERED
FIPAHIREZERTRT B,

Reset
Execute / Cancel

Server SettingsDER EAHIFMEICRT.
Execute : &7

Server Server Settings 1£EL
Settings2
Server Server Settings &@LU
Settings3

Network>Network Reset
XyRD—IDREZ)LYNLET,

AZa-I5E MWMBLREE

S

Reset Execute / Cancel

XYRD—IDFEEE VYRS S,
Execute : 17




Maintenance X _— 11—

EAZ1-THHOWES LUREMERIUTOESY TT,

Maintenance>Hours Meter

S

BEFERRB(U Y NRE) 2RRT 3,

BEGERARE() Y M) 2R7T 3,

Hours(Reset) ®R&0IC) Ly T3,
Execute : 1T

S

TIZHERFOYHAR EMEE. AXF(HI:18dB) TRLF T, BHEESEBAERRLET,
. AZa-1H MBEHREME
Maintenance>Language
ERTBEEARELET. Hours
— — — (System)
AZa-IEH MELHRERE AE
= R Hours
Select im?égﬁg%ﬁﬁﬁjéa (Reset)
SET- X147 Reset Execute / Cancel
Maintenance>Clock Set
Wﬁﬂ%ﬁ’r(:ﬁﬁ?’éﬁ_’x‘m%ﬁb\i?} VRl e Gl
AZa2—18H HMBEREE RnE N=o 3 %RRLET,
Time Zone  UTC-12:00 ~ UTC +14:00 UTCH S DEEER300 BN TRET 3. AZa-—1H MBELHREME
Date Mode YYMMDD / MMDDYY / DDMMYY FAHORTRARZREIRT 3. Version VXXX
YYMMDD : £AH®D|E Number

AEDY TR T TPN—TavaERRT B,

MMDDYY : BHEODIE

DDMMYY : B BEDIE Version Up  Execute / Cancel

12h/24h 12h / 24h

KzlORRERZRIRT 3.
12h : 12K &R

KigEN—-Ta 07y T3,

Execute : 17

*N=TIvTPYTREAEOV IR IITET Y
TF—NTBHEETT.

24h : 24 R &R Lens Version Vxx

EXOYRLYZDY IR FPN—T30F
BHERRNT S,

Date REOCHG%ERET 3. Number
SET: RE

Time REORFZEZHRET 3.
SET:RE

Maintenance>All Reset

TIZHERORREICUEYRLET,

AZa-—18H HMBEEHREE AA

Reset Execute / Cancel TIZHEROREADU LY NEEITT
%,
Execute : 17
=3=
Paint/Look A= a1—®Base Look®Import
(NR—%) TAViR—KLE3D LUTT 7L
IFHIBR I NEBA, 1V R—KLE3DLUTT 7
1L %I T 215 E 1%, Paint/LookA=a1—
MBase Look®dDelete AllZE{TLTLETW
(91=—3),

Reset Execute / Cancel Network A Z 2 =BT OFREZFRL oA

without Za—REEEIIGHERECEY N

Network %,
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68 AZa—FRREFHMRTE

ShootingA— 21— D&%

ISO/GainA = 21— DR EE L ¥EAE

Mode. Target Display. Base Look®Select. Base SensitivityDE&E(ICL>T.

ModeMhISOD & F

ISO/GainAZa1—

axX AE '1 C\:*]JH\H'f [CDWT

(78 R—2) DRELHELMIENRRBYVE T, JL—DO&HENRETEE

TMETTY,

Target Display

SDR(BT.709)

HDR(HLG)

SDR(BT.709). HDR(HLG)t:&

Base Look®Select

S-Cinetone / Standard / ITU709 / Still

HLG Live / HLG Natural

User1 ~ User16

Base Sensitivity

Low

High

Low

High

Low

High

1SO 320

ISO/Gain<L>#]HA1&

I1SO 400

I1SO 500

ISO 640

ISO/Gain<M>#]E3{&

1ISO 800

ISO/Gain<L>#H31E

I1SO/Gain<L>#1#31&

1ISO 1000

1SO 1250

ISO/Gain<H>#]HA1&E

1SO 1600

I1SO/Gain<M>#Hi1&

1SO/Gain<M>#]HA1&

I1SO 2000

I1SO 2500

I1SO 3200

ISO/Gain<H>#]HAE

ISO/Gain<H>#]#A1E

ISO 4000

ISO 5000

I1SO/Gain<L>#1#A1&

I1SO 6400

ISO 8000

1ISO 10000

1SO/Gain<M>#]HA1&

1SO 12800

ISO/Gain<L>#HA1&

ISO/Gain<L>#]#A&

1SO 16000

1SO 20000

1SO/Gain<H>#H31&E

1SO 25600

ISO/Gain<M>#]HA &

ISO/Gain<M>#]E3{&

1SO 32000

1ISO 40000

I1SO 51200

ISO/Gain<H>#]HA1&

ISO/Gain<H>#]HAE

ISO 64000

1ISO 80000

1SO 102400

1SO 128000

1ISO 160000

I1SO 204800

I1SO 256000

1ISO 320000

1SO 409600




M0  6F AZa—FRREFHFMELTE : ShootingAZ 21— DREMEEHEEICDOWVT

ModehdBmn & *

5% € &
—3dB
—2dB
—1dB
0dB ISO/Gain<L>#]Hi{&E
1dB

2dB
3dB
4dB
5dB
6dB ISO/Gain<M>#]HA &
7dB
8dB
9dB
10dB
11dB
12dB ISO/Gain<H>#]HA1&E
13dB
14dB
15dB
16dB
17dB
18dB
19dB
20dB
21dB
22dB
23dB
24dB
25dB
26dB
27dB
28dB
29dB
30dB
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6T A a1—RNEFHFMERTE  ShootingAZ 21— DREBEEHEEICDVT

AGC LImitAZa—o

R EMEEHIHAE

Mode. Target Display. Base Look®Select. Base Sensitivity®E&ECL>T. AGCLiMitAZa— (80R—) OREFHEELMEENELZVET, FL—0EHBENRETRELETT,

ModeMhISOD & F

Target Display

SDR(BT.709)

HDR(HLG)

HDR(HLG)

SDR(BT.709). HDR(HLG)t&

Base Look®Select

S-Cinetone / Standard / ITU709 / Still

HLG Live

HLG Natural

User1 ~ User16

Base Sensitivity

Low High

Low

High

Low

High

Low High

ISO 400

I1SO 500

ISO 640

I1SO 800

1ISO 1000

1SO 1250

1SO 1600

ISO 2000

#IHAfE

I1SO 2500

I1SO 3200

ISO 4000

ISO 5000

#IHAfE

HHE

#HAE

I1SO 6400

ISO 8000

1ISO 10000

1SO 12800

1ISO 16000

I1SO 20000

1SO 25600

1SO 32000

#IHAfE

1ISO 40000

I1SO 51200

ISO 64000

1ISO 80000

¥IHAfE

#HHAE

#IHAfE

1SO 102400

1SO 128000

1ISO 160000

ISO 204800

I1SO 256000

1SO 320000

1ISO 409600
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ModehdBmn & *

Bl

ax A&

EEHHAMEICDWT

REHHE

3dB

6dB

9dB

12dB

15dB YIAfE

18dB

21dB

24dB

27dB

30dB




68 AZa—FRNEFHFMERE

B E—NZEOBEEICETHREREDRFICDOVT

EECET2HREEER. UTOREE-—RQ5R—) JELCREOHRERENRIFINET, WEET—RE2VIVEZZ L. YIWVBZROEBREE-RIRISITIHZERENBRINET,
e CustomE—R®OSDR(BT.709)
e CustomE—KR®DHDR(HLG)
e Cine EIE—K
BEHEICETEREREIREE—RIEICUTOLSCREINET,
Yes : REINFET
No: REINEHA

REEE REE
CustomE—F‘ Cine EIE—R
SDR(BT.709) ‘ HDR(HLG)
ShootingAZa— ISO/Gain/El ISO/Gain Yes" No
Exposure Index No Yes
Base Sensitivity Yes No
Base ISO No Yes
White Preset White Yes Yes
LEUH Yes
White Setting Yes
Offset White Yes No
LUT On/Off No Yes
Noise Suppression Setting(Custom) Yes Yes No
Level(Custom) Yes Yes No
Setting(Cine El) No Yes
Level(Cine El) No Yes
Paint/LookAZa1— Base Look Select Yes Yes Yes
Input? Yes
Output? Yes
AE Level Offset? Yes
Black Yes Yes No
Knee Auto Knee Yes No No
RS Yes Yes No
Detail Yes Yes No
Matrix Yes Yes No
Multi Matrix Yes Yes No

1) ISOREICDWTIE. CustomE—R®DSDR(BT.709). HDR(HLG) TR EMEHERICREINZHZEHHYET,
2) &R EfEIEBase LookZ L IREFINTH Y. FREE-—RICIHKELEZEA.
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BRET— Y DRI
RET—4

TIAZa—DREHNB . KHEDCFexpress
Type A/SDA—KRZOv N B) ICEALEAE
J—H—RIRETZIENTEET, 2OFT—
SEFESTEYGEY NPy TIREATIEDL<E
WTEFET,

BET—YIE. ROLSCHFEINTHRETN
¥7.

User File(2—Y—771)JL)

HAIIA X LIcUserdA —a— DR EEEERE
F—9EFRELET,
AEV—H—RICOAEFETRETZIELNTE
E3

ZOTFANERBEOAT) —CFHRMMHAL &I
&Y. UserAZa—%HhHR9I1 X LIIREEIC
TyNPYTITRIENTEET,

All File(ALLZ 7JL)
EAZI-DBEF—IEREFELET, AEU—
H—RIC6MBETRETZZENTTET,
[TFE]

BREEOT—Y (BB CHENVERYI—FT (VY
PHALRIERE) BREINE A,

1A I+

A—Y—TJ7A4)L, ALLZ7 74
W REFETS

1 AE—hH—K%CFexpress Type A/SD
H—RZ20OvkB) (6/R—) ICELRA
L,
o CFexpressh—RDIFEIFSNILEEIC
EE:R
e SDA—RDFHIFSINILEAEIC
REBETICT 2,

Lo

2 1-9-TI7(LOBAE. INAZa—
DProject A Za1— >User File®Save
Media(B)(90R—<)) T. Execute% &
RT3,

ALLZ 7ML DFZEIE. TILAZa1—0D
ProjectX = a1—>All File®Save Media(B)
(90R—3) T. Execute%:#EiR9 3,
T7ALVOREFLAEBEANEZRINET,

3 REEEEONO FileD T4 RIRT 3.
File DA I NTVBTARRT B L.
ZDT AL LBESNET,
File IDEEBIMICA T SNET A,
BTLLTEET,

EEY

4 wemEEOExecutes BIRT 3.

dA—Y—TJ7A)L, ALLT 74
LG FHIAD

T 77 nzgELrrsU—p—r%
CFexpress Type A/SDA—RzOv k(B)
(6R—Y) ICZELAL,

o CFexpressh—RDIFEIESNILEEIC
g3,

¢ SDA—RDFEIEIRNILERIC
REBETICT 3,

Lo

2 1-Y-I7(LOBAEEF. TIAZ2—
MDProject A= a1—>User File®Load
Media(B)(90~R—<) T. Execute% &
RT3,

ALL771ILDHEIF. TIAZ21—D

ProjectX = 21— >All File®Load Media(B)

(90R—3) T. Execute%EiRT 3,
TF7AIILO—EEENKRRINET,

3 FRAGTILERRT S,
SEENERINET.

4 ExecutenBRT 3.

[TEE]

o MET—YEFHFHATE., AEIEBNICHESHIN
E 8

o JJLAZa—DProjectAZa— >All FiledLoad
Network Datah'Offdiz & E. NetworkAZa—d
BEBEBEBRVEALLT 7ML A5 HAH T,

File IDZZEE T 5ICIE

T a—v—oroman. suxza-
DProject A= a1—®User FileT. File ID
(90R—2) 2 #EIRT 3,

ALLZ 7ML DGFEIF. TIAZ1—D
Project X = a2—®All FileT. File ID(90
R—I) #&EIRT 3,

File DOMGREBENKTINET,

2 TAFELII— (17—Y) FFld7IL
FIPI2aVFALVILGER—I) T
XZEHFRL. IIILFELIYI—DRERY
VERECILFTI VI AV VI
ER

3 FEArBYUET

A wspAADET LI5S, Donek BIRT 3.
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TR SMERRER R

NEBEZY — P =EZ &t I 5

S8R BEEBENBEI—CRTTERLEE
(. AgEOHAESEREIRL., ERTZ2EZS—
ICISCERT—TILAFERLTETV,
VTRIGEDEREEZERLT. AEOHAE
BHERTZIEETEET,
NBEZY—ICE2—T7A VY- LEIKRDERE
2T = AEROA 21— HEERRIEBRE
NTEXYT, EZY—ICHATBRESITHLT.
Monitoring X5 —4 Z®Info. Disp.(15R—
D). £rETIAZ 2—DMonitoringA=a—
®Output Display(95R—) ZOnlcEREL
TLIET W,

SDI OUTi#H+(BNCEY)
MonitoringA=a— (95R—%) T, HAD
On/Off P AT+ - v b ERELET,

BRCEMRO7T5QEE T —TILEFERLTLE
T,

(T3]
AR ENTHBOBOT—INBEICEINTVWS L
zHELTHS, EBREANTILEL,

(T5QRE#7 —TIL =R Llci(c. FENE
WEDEREANS I L2HEHLET.)
PUERF/Y. BEREBARETHRHSEZERT
BimEE. 15SQRET —T L& SR ER (C R
LIicRIC, AfEERLTIET VL,

s Tl 1] : S ST et v e el e
gBICE

SDUEBSHARFIE., TILAZ 21— DProjectA
— 11— >SDI/HDMI Rec Control(87_—

) MSetting%SDI/HDMI Remote I/FE 1
Parallel ReclCE&E T3 &. SDI OUTIHF (T
BeL N33 (CRECR U H—{EB 2N T3
ElC&oT. AEEEBLIERERMNATREC AW E

[TEE]

o EFELIAEMESINRECK U A —ESICHIELTVAWN
AEILEMELE A

o AFATHBATNTVLEWVEEFE, RECRUH—ES
OHEAENET,

HDMI OUT#:HType A%
74 —)

TILAZa—dMonitoringA—a1— (95—
) T HADON/Off PHAT+—T v &R
EFLET,

AL EBFCH BRI ES TR iR FtR
gBICE

HDMIESHA1B%(E. ZILAZ2—0DTC/Media
A= a—>HDMI TC Out®Setting(93 R—

¥) %#0nlcLT. ProjectA=a— >SDI/HDMI
Rec Control®Setting(87—<) #SDI/
HDMI Remote I/F¥fzIZParallel RecIZE&E
g3&. HDMI OUTIRFIcHft LIz HNER %R 1C
RECANUAH—ESEE AT R LCLoT. Kk
EEEALEERMATREIC AR Y £ T,
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SA4ALI—REEHES

AEEOIALD—REMECEHDERZZENTE
x7.

DY« LI—KIlCOyy
T3

SALD—RERTRERZHERIE. 9/L0—-R
HANEHFRINBE—R(Free Runt>Clock) I
RELTLT L,

T snxza-oTc/Mediax=2-0
Timecode(93R—) RO LS ICHRE
I3,

Mode : Preset
Run : Free Run

2 DURATION/TC/U-BITH#EENEIY YT SN
e PHAFTILRY > (51R—) 2L
T. BAICYAILI-RERRTES,

3 TCIN/OUTEIWEZ XA v F(AR—)
MINRICIE>TWBZ &E&REEEL. TCIN/
TCOUTIRFIC. AMD>ZTLEFEIC
EHAL B LTI— REMIET 3,

INTEABOIALI—RI TR —Y—HiE%EE
Y4 L0—-RicOyvs L. BE@EICTEXT-LKI &%
REINET,

Ov7 LTHhofMI0MRBELEIF. NS
DOEESALTD—-ROERZALTD. SOy
JREFRIENET,

[TEE]

o ABOVIDEFETZE. 9L RIIBREFICHER
DYALT—RicOvs L, MBYALI—-FDEERL
EDNY A LT —IRTREBICHETH, §14L40—-KIx
XL—F—NRETZFTOHRMEIL. CREBBLA
WTLETW,

o EEHSALI-ROFRBEREOT L —LBAREHE
LThRVE, ELLOYITEY. AEDNEFECEIET
FTEBA. COBE. YL —-RBAEOYALO—
RIZIELLOvITEEEA.

o HEHSALI-RICHLIBEETIZL-—LTNZHEH
BYVET,

NEROw 7 = BERR TSI

TIAZa3—DOTC/MediaAXA=Z a—DTimecode
DFREZEELTIETL,
SZTLRAREEEELIIGE Y. HHELRE—
RRO-&TAvIE—VavERIFAVF—NI
ILyy) TOREERBLEESES. SOy
VISR INET,

DY A LT— R n
HA4LD—REEDHES

SALD—REGREGZHERE. 97L0—K
HANEHFRINBE—R(Free Runt>Clock) (2
FRELTLETY,

1 Itz 2—0TC/Mediat=2—0
TimecodeTAD YA LI—RERETS
(93—,

2 TCIN/OUTEIWEZ 2 v F(AR—)
MOUTRIICIEoTWBZ &EARERRL. TC
IN/TC OUTitF%. REATBlzLEERDS
AL O—RAHBFICERTS,
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TR SMERRER R

e

AVE1—4Y—TO)wTER - fRETS

USBT—JILZfE>THiRT
%

h—kU—4— (RI7E) 2>

Jd>Ea—4%—I(CCFexpress Type AA—RK1—
H—Ff1FSDH—R) =4 —HUSBT—TILTH#H
mIBdE. HA—RU—F—DROVMEEIN
EAE'Y—H—RNI>E21—9—DIERRSA
TJELTRATNET, b WElLizavEa—
Y—DiEa. AEOIIAZAN —JE—REZFEH
TERLVEERIC, FJIYTERWALGZENT
TET,

AEODIZZANL—JE—REFES

[TEE]

TILAZ a—DNetworkA = 21— >Modem®SettingH
On. F7zlENetworkA=—a1—>Wired LAN®DSettingh’
ONICEREINTWVBRIZEER. YRAAML—IYE—REMES
ZENTEFRA. MALEOfICERELTIIETL,

AEEUSBT—TJILTHER TS L. A—R20OY
RA/BIZEBEINAETY—H—RHAIVEa1—
I—DIRR S TELTRHMINET,
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VIEASR EfEIZ. AXF(f:1920% 1080P (Level A)) TRLE T,

[TEE]

o HHT74—TvhDFEKEIETILAZ 21— DProjectA = a1— >Rec Format®Frequency. Codec$ &UVideo
FormatDi&EIC & >THIRTNF T (84R—),
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OUTIHRFDHEAT#—T Y RDRICMRAT. UATORERHEIANTHLTHE. HDMIEAEFHDUTICKRY T,
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- ShootingX = 2 — >5&Q Motion®Frame Rate h60fps% Bz 2 1&
- ProjectA = 21— >Rec Format®CodecMRAW, RAW & XAVC-IOWENh., Fizld. MonitoringA=1—

>Qutput On/OffdSDIAON
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X2160P/3840X 2160PL x> TWBEIREEIF T L —F I T NEBIR TRV ET,

o BEEROBEREIVATLBEBENRETNTVIGRE. BEIHATNEEA.

SDI OUT/HDMI OUTImFDHAT#—<Y v k

2T LRAREER CodecsRE RAW/ERE 74 —<vy HHT7+—< vk (MonitoringA=a1—

iE (ProjectA=a— K&RE >Qutput Format)
(ProjectA=a1— >Rec Format® (ProjectA=a— SDI HDMI
>Rec Format® Codec) >Rec Format®RAW
Frequency) Output Format/
Video Format)
50/59.94Hz RAW 4096%2160(RAW)  (4096%2160 4096X%X2160P
RAW & XAVC-| RAW) 3840%2160P
1920X1080P
1920X%1080i
3840X%2160 (RAW) (3840%2160 3840X2160P
RAW) 1920 1080P
1920X%1080i
RAW(HDMI) 4240%2392(RAW)  1920X1080P (4240% 2392
RAW(HDMI) & (Level A) HDMI RAW)
XAVC-| 1920X1080P
(Level B)

1920X1080i

27 LRABEE CodeciE RAW/SE 7 #—<y HAT#—< v (MonitoringA=a1—
E (ProjectA=a— KEE >Output Format)
(ProjectAZa— =>RecFormat® (ProjectA=a— SDI HDMI
>Rec Format® Codec) >Rec Format®RAW
Frequency) Output Format/
Video Format)
50/59.94Hz XAVC- 4096x%2160(Video) 4096x2160P" 4096X%X2160P
XAVC-L 4096 X 2160P 1920X1080P
4096X%2160P 1920X%X1080i
3840X%2160P 3840X%2160P
3840X%2160P 1920X1080P
3840X%2160P 1920X1080i
1920x1080P 1920x1080P
(Level A)
1920x1080P 1920%1080i
(Level A)
1920X1080P 1920%X1080P
(Level B)
1920X1080P 1920X%1080i
(Level B)
1920X%1080i 1920X1080i
3840X%2160(Video) 3840X2160P 3840x%2160P
3840X%2160P 1920X1080P
3840X%2160P 1920X1080i
1920X1080P 1920X1080P
(Level A)
1920X1080P 1920%1080i
(Level A)
1920X1080P 1920%X1080P
(Level B)
1920X1080P 1920X1080i
(Level B)
1920X%1080i 1920X1080i
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E (ProjectA=a— KERE >QOutput Format) iE (ProjectA=a— KE&E >0Output Format)
(ProjectA=a— >Rec Format® (ProjectA=a1— SDI HDMI (ProjectA=a— >RecFormat® (ProjectA=a— SDI HDMI
>Rec Format® Codec) >Rec Format®RAW >Rec Format® Codec) >Rec Format®RAW
Frequency) Output Format/ Frequency) Output Format/
Video Format) Video Format)
50/59.94Hz XAVC-| 1920%X1080(Video) 1920X1080P 1920X1080P 23.98Hz RAW 4096%2160(RAW) (4096X%2160 4096X%X2160P
XAVC-L (Level A) RAW & XAVC-I RAW) 3840%2160P
1920%1080P 1920%1080i 1920X1080P
(Level A) 3840 2160(RAW)  (3840%2160 3840%2160P
ZEQZ\S);ﬂB()JBOP 1920%x1080P RAW) 1920X1080P
- RAW(HDMI 4240X2392(RAW 1920X1080P 4240X2392
23;\?518?8@ 19201080 RAWEHDMI; & (AW 15201080 E—|DMI RAW)
XAVC-|
19201080 1920% 10801 XAVC| 4096%2160(Video) 4096x2160P"  4096x2160P
(HiA L) ;zgi:;f;)s) XAVC-L 4096x2160P  1920x1080P
3840X2160P 3840X2160P
25/29.97Hz ﬁﬁw & XAVC 4096X 2160(RAW) (F?:\?V?X 2160 :gzg:;:g:’ 3840% 2160P 1920X1080P
1920X1080P 1920X1080P
1920)(1080'? 3840X%2160(Video) 3840X2160P 3840%2160P
1920x1080i 3840X2160P 1920X1080P
3840%2160(RAW) (3840X%2160 3840X2160P 1920X1080P 1920X1080P
RAW) 1920x1080P .
1920%1080(Video) 1920X1080P 1920X1080P
1920x1080i 24Hz RAW 4096%2160(RAW) (4096X%2160 4096X%X2160P
RAW(HDMI) 4240%X2392(RAW)  1920X1080P (4240%2392 RAW & XAVC-I RAW) 1920X1080P
RAW(HDMI) & 1920%1080PsF  HDMI RAW) -
YAVC-I RAER RS XAVC-| 4096x2160(Video) 4096x2160P"  4096X2160P
XAVC-| 4096x2160(Video) 4096x2160P"  4096X2160P 1920x1080P  1920x1080P
XAVC-L 4096 2160P 1920X1080P ) BERROEBETEF A,
3840x2160P  3840x2160P 2) AT LRBEBNS.S4DLE,
3) YATFLRBABEENS50DLF,
3840X%2160P 1920X1080P
1920X1080P 1920X1080P
1920X1080PsF  1920X1080i
3840X%2160(Video) 3840X2160P 3840X2160P
3840X2160P 1920X1080P
1920X1080P 1920X1080P
1920X1080PsF  1920X 1080i
1920X1080(Video) 1920X1080P 1920X1080P
1920X1080PsF  1920X 1080i
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Media Temperature WS RUR CFexpressh—ROBEMNERLELE,

High H—RER{TEH. BEHNTHZETH—ROE
AEHIELT TV,

Voltage Low W =y DCINBEMELSL A>TV E T (R, #EER%E
LT IET W,

Insufficient Voltage &S EEA®  DCINEEMMET T I(ERRE2). RIFTETHEA.
HOERICERLELTI LTV,

Media Near Full Wi e R AEY—H—ROEKEHNDELIE>TVET,
BOESICRIBELTLLETW,

Media Full e =R U AE)—H—ROEENLZ W\, LR, IE—ET
TEtA.
RIBELTLIET W,

Clips Near Full g =1 =V AEY—H—RICEFTEZRVOI )y TEH DI
<HOTWET,
BOBSERIRLTET WY,

Clips Full ERE =R RUH AEY—H—RICERTETZ 7 Vv THOLRICEL
FL
INBERRBPIC—ITERHA, KBLTKET
W,

Last Clip Recording B s =V SERPOV)YIDOREBRETT IS L. SLRAIBEGY
Dy TEOLERISGELET,
FLOAEY—H—REZABRETVL,

Media(A)" Life Near Wi R AEU—H—ROEGHEMNTT, BHICRIBLTL

End EEu,

Media(A)" Life End  &EfEE EEEE AERU-H—RoFGNEELE, JBRLTKESWY,

Media(A)" Near Full  Bf#sss =7 [EBS SO ER M AL E AR B

Media(A)" Full ERE =R U FIBFSCERI% BE (F FI B

Media(A)" Clips BEE =¥z [ B ST SR AE {55 P B
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Media(A)" Last Clip  Bfifss =¥ EIBFSCERI% BEF FI B
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EVYYRLY SR CLYAI/FRETLYIDREAHNRE
ThElLrk.

EVOY LY EDEEIREEBEIELTIRETL,
HELHWEEIF., VI—OY—EXBYFCIS—O—REE

A T
MLTLIEESL MADSXE) #HEZLETL,
ECGNRES FRREMTR This Multi Term. acc is not EREOTI ) —hEHEIhE L,

Battery Error
Please Change Battery

Ny F )=y I CEEHNREINEL,
EFBGNyTFU—=yICILTIEE W,

Backup Battery End
Please Change

Ny o7y TEMDEZENFTELTVWET,
Ny o7y TEMETELTLET,

supported by the device and
cannot be used.
Please verify the compatibility.

NSNS TEIINFHEFFIEHU—E. FBOST Uy TIE
AVDOHTY,

Unknown Media(A)"
Please Change

N=T423arvhYENTVBAE)—H—RKP, KIETHKRZ B
Uy THEBITERBINLEAT) —H—RHEATNELE,
AETREATTELADOT, RBLTLETL,

Failed.

DHCP ONT7 RLZHWEIYH TSN WFE, AIS—HH3
AIREME N BY FT,
DHCPH —N—DREZMHELTIIZEL,

Cannot Use Media(A)"
Unsupported File System

T7ANIRATLADEREZH—RERET -y hETNTVAEWL
H—RHBATNFELE,

AETREATTEFLADT, KIBFBAETTIF—Tv AL
TLIETV,

Cannot add auto upload job of
Proxy file because maximum
number of upload jobs was
reached.

XY I TOHDERIGELTVWET,
RERI3THEIUTPLLKETY, e, TOF3T770)L08
BERSTEREHDEES TV RN HBYE T, IELERELT
WBDEESELTET W,

<SSID>Not found.

EBELE<SSID>DRy hI—2(FUERKRAVKR) BRDODWF
Th.
ELKERELTVAHRERLTET W,

Media Error AEY—H—RICEEHNREL. EEHNLELREICEYELE,
Media(A)’Needs to be Restored ~ AEU—H—ROEEEToTIET,
Media Error AEY—H—RKHELT, BN TETHEAEYELE,
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BERTRETIOT, AE—%EZRELT. HILLAEY—H—
RICRIrg B EaBBOLET,

<SSID>Authentication Failed

IBELRE<SSID>D XY hT—2(FUEXRA > N) OFEFEREEIC
LHMLELE,
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Media Error
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AETHMRAELBADT, DD —RICKIRLTILETW,

Media(A)"Error
Recording Halted
Playback Halted

AEY—H—RICEEHRELH. BRELEIBEINFLEL
FLI.
BREICEIZHERICIE. AEV—H—REZRLTRET W,

An IP address conflict has
occurred. Please check the
network settings.

TAVLZLANEBRRELANDUSBF UV I EEDORY NT—2
FRLZDBERLTWVWET,

FPRLZZFHTEETEIH. BEVDORYLT—-TIL—-5—-D
REEEBELTETY,

Media Reached Rewriting Limit
Change Media(A)"

AEU-hH-—RoFaNTFELL.
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FLLE, AR —H—FORRHBAELZSRLTIETL,

The IP address of the Wireless
LAN Access Point Mode has been
changed due to an IP address
conflict.

TAVLIALANT 7 EZRA > M E—REFHRLAN, F£7zIFUSB
THIYIDRY RI—I P RLIADNMERLIcfeéh. T1V LR
LAN7ZEZRA YR E—RDIPPRLAEZEELFLE,
IPPRLRZHRLTIIET W,

The specified address is invalid.

EBELEZRLADEE>TVET,
ELERELTVWANEESEL TRV,

Cannot Use Specified Port
Number

EBELA-FMESHEESTVET,
ELSERELTWSHHEERLTIRE L,

Fan Stopped

AEROT 7o MELELTVET,
BRETTOFERAZET, EBREY>TYI—0Y—EBYEC
EIRLTETW,

1) 20v kBIZANT=H—RDIFE1Z(B)
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T714ILICREINSIE

FILA= 1—(C £ BB FIEE LEVEL1 LEVEL 2 LEVEL 3 All File IS:,iclgne
Shooting Auto Exposure Level Yes No
Yes : TP AIICREFINET Mode Yes No
No: 77AILICRETNE A
— TP ALCRES NE A (—BEBEA = 1) Speed Yes No
LEVEL 1 LEVEL 2 LEVEL 3 AllFile  Scene AGC ves  No
File AGC Limit Yes No
Shooting ISO/Gain/El Mode Yes No AGC Point Yes No
1SO/Gain<H> Yes No Auto Shutter Yes No
1SO/Gain<M> Yes No A.SHT Limit Yes No
1SO/Gain<L> Yes No A.SHT Point Yes No
Exposure Index<H> Yes No Clip High light Yes No
Exposure Index<M> Yes No Detect Window Yes No
Exposure Index<L> Yes No Detect Window Indication Yes No
Shockless Gain Yes No Custom Width Yes No
Base Sensitivity Yes No Custom Height Yes No
Base ISO Yes No Custom H Position Yes No
ND Filter Presetl Yes No Custom V Position Yes No
Preset? Yes No White Preset White Yes No
Preset3 Yes No Color Temp <A> Yes No
Shutter Mode Yes No Tint<A> Yes No
Shutter Speed On/Off Yes No R Gain <A> Yes No
Shutter Speed Yes No B Gain <A> Yes No
Shutter Angle Yes No Color Temp <B> Yes No
ECS On/Off Yes No Tint<B> Yes No
ECS Frequency Yes No R Gain <B> Yes No
Iris Bokeh Control No No B Gain <B> Yes No
White Setting Shockless White Yes No
ATW Speed Yes No
White Switch<B> Yes No
Filter White Memory Yes No
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LEVEL 2 LEVEL 3 All File  Scene LEVEL1 LEVEL 2 LEVEL 3 All File  Scene

File File
Offset White Offset White <A> Yes No Project Base Setting Shooting Mode Yes —
Offset Color Temp<A> Yes No Target Display Yes —

Offset Tint<A> Yes No Rec Format Frequency Yes No

Offset White <B> Yes No Imager Scan Mode Yes No

Offset Color Temp<B> Yes No Codec Yes No

Offset Tint<B> Yes No RAW Output Format Yes No

Offset White<ATW> Yes No Video Format Yes No
Offset Color Temp<ATW> Yes No Cine El Setting Color Gamut Yes —

Offset Tint<ATW> Yes No HDR Setting VF SDR Preview Yes No

Focus AF Transition Speed Yes No SDR Gain Yes No
AF Subj. Shift Sens. Yes No Simul Rec Setting Yes No

Focus Area Yes No Rec Button Set Yes No

Focus Area (AF-S) Yes No Proxy Rec Setting Yes No

Face/Eye Detection AF Yes No Audio Channel Yes No

Push AF Mode Yes No Interval Rec Setting No No

Touch Function in MF Yes No Interval Time Yes No

AF Assist Yes No Number of Frames Yes No

S&Q Motion Setting Yes No Pre-Lighting Yes No
Frame Rate Yes No Picture Cache Rec Setting Yes No

LUT On/Off SDI/HDMI Yes No Cache Size Yes No
VF/Proxy/Stream Yes No Cache Rec Time — —

Internal Rec Yes No SDI/HDMI Rec Control Setting Yes No

Noise Suppression Setting(Custom) Yes No Assignable Button <1> Yes No
Level(Custom) Yes No <2> Yes No

Setting(Cine El) Yes — <3> Yes No

Level(Cine El) Yes — <4> Yes No

Flicker Reduce Mode Yes No <5> Yes No
Frequency Yes No <6> Yes No

SteadyShot Setting Yes No <7> Yes No
<8> Yes No

<O> Yes No

Focus Hold Button Yes No
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LEVEL 1 LEVEL 2 LEVEL 3 All File  Scene LEVEL1 LEVEL 2 LEVEL 3 All File  Scene
File File
Project Assignable Dial Grip/Remote Dial Yes No Paint/Look  Detail Setting Yes Yes
Grip Dial Direction Yes No Level Yes Yes
Handle Dial Yes No Manual Setting Yes Yes
Handle Dial Direction Yes No V/H Balance Yes Yes
Multi Function Dial Default Function Yes No B/W Balance Yes Yes
User File Load Media(B) — — Limit Yes Yes
Save Media(B) — — Crispening Yes Yes
File ID No No High Light Detail Yes Yes
Load Customize Data Yes No Matrix User Matrix Yes Yes
Load White Data Yes No User Matrix Level Yes Yes
All File Load Media(B) — — User Matrix Phase Yes Yes
Save Media(B) — — User Matrix R-G Yes Yes
File ID Yes No User Matrix R-B Yes Yes
Load Network Data No No User Matrix G-R Yes Yes
Paint/Look  Scene File Recall — — User Matrix G-B Yes Yes
Store — — User Matrix B-R Yes Yes
Delete — — User Matrix B-G Yes Yes
Preset Recall — — Multi Matrix Setting Yes Yes
Base Look Select Yes Yes Reset — —
Delete — — AXis No Yes
Delete All — — Hue Yes Yes
Import — — Saturation Yes Yes
Input Yes Yes
Output Yes Yes
AE Level Offset Yes Yes
Reset Paint Settings  Reset without Base Look — —
Black Master Black Yes Yes
R Black Yes Yes
B Black Yes Yes
Knee Setting Yes Yes
Auto Knee Yes Yes
Point Yes Yes
Slope Yes Yes
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LEVEL 1 LEVEL 2 LEVEL 3 All File  Scene LEVEL1 LEVEL 2 LEVEL 3 All File  Scene
File File
TC/Media Timecode Mode Yes No Monitoring  Display On/Off Network Status Yes No
Run Yes No File Transfer Status Yes No
Setting No No Rec/Play Status Yes No
Reset — — RAW Output Control Status Yes No
TC Format Yes No Tally Yes No
TC Display Display Select Yes No Battery Remain Yes No
Users Bit Mode Yes No Focus Mode Yes No
Setting No No Focus Position Yes No
HDMI TC Out Setting Yes No Focus Area Indicator Yes No
Clip Name Format Title Prefix Yes No Focus Area Ind.(AF-S) Yes No
Number Set No No Face/Eye Detection Frame Yes No
Update Media Media(A) — — Lens Info Yes No
Media(B) — — Imager Scan Mode Yes No
Format Media Media(A) — — Rec Format Yes No
Media(B) — — Frame Rate Yes No
Monitoring  Output On/Off SDI Yes No Zoom Position Yes No
HDMI Yes No UWP RF Level Yes No
Output Format SDI Yes No SteadyShot Yes No
HDMI Yes No Base Look/LUT Yes No
Output Display SDI Yes No SDI/HDMI Rec Control Yes No
HDMI Yes No Gamma Display Assist Yes No
Proxy Status Yes No
Base ISO/Sensitivity Yes No
Media Status Yes No
Video Signal Monitor Yes No
Clip Name Yes No
White Balance Yes No
Scene File Yes No
Focus Indicator Yes No
Auto Exposure Mode Yes No
Auto Exposure Level Yes No
Timecode Yes No
ND Filter Yes No
Iris Yes No
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LEVEL 1 LEVEL 2 LEVEL 3 All File  Scene LEVEL1 LEVEL 2 LEVEL 3 All File  Scene
File File
Monitoring  Display On/Off ISO/Gain/El Yes No Monitoring  Zebra Setting Yes No
Shutter Yes No Zebral Level Yes No
Level Gauge Yes No Zebral Aperture Level Yes No
Audio Level Meter Yes No Zebra2 Level Yes No
Video Level Warning Yes No Audio Audio Input CH1 Input Select Yes No
Clip Number Yes No CH2 Input Select Yes No
Notice Message Yes No CH3 Input Select Yes No
Marker Setting Yes No CH4 Input Select Yes No
Color Yes No INPUT1 MIC Reference Yes No
Center Marker Yes No INPUT2 MIC Reference Yes No
Safety Zone Yes No Line Input Reference Yes No
Safety Area Yes No Reference Level Yes No
Aspect Marker Yes No CH1 Wind Filter Yes No
Aspect Mask Yes No CH2 Wind Filter Yes No
Aspect Safety Zone Yes No CH3 Wind Filter Yes No
Aspect Safety Area Yes No CH4 Wind Filter Yes No
Aspect Select Yes No CH3 Level Control Yes No
Custom Aspect Ratio Yes No CH4 Level Control Yes No
Guide Frame Yes No CH3 Input Level Yes No
100% Marker Yes No CH4 Input Level Yes No
User Box Yes No Audio Input Level Yes No
User Box Width Yes No Limiter Mode Yes No
User Box Height Yes No CH1&2 AGC Mode Yes No
User Box H Position Yes No CH3&4 AGC Mode Yes No
User Box V Position Yes No AGC Spec Yes No
VF Setting Brightness Yes No 1kHz Tone on Color Bars Yes No
Color Mode Yes No CH1 Level Yes No
Gamma Display Assist Setting Yes No CH2 Level Yes No
Peaking Setting Yes No CH3 Level Yes No
Peaking Level Yes No CH4 Level Yes No
Color Yes No
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LEVEL 1 LEVEL 2 LEVEL 3 All File  Scene LEVEL1 LEVEL 2 LEVEL 3 All File  Scene
File File
Audio Audio Output Monitor CH Yes No Technical Color Bars Setting No No
Volume No No Type Yes No
Headphone Out Yes No ND Dial CLEAR with Dial Yes No
Alarm Level Yes No Tally Front Yes No
HDMI Output CH Yes No Rear Yes No
Thumbnail Display Clip — — HOLD Switch Setting  with Rec Button Yes No
Properties with Hand Grip Remote Yes No
Set Clip Flag Add OK - - Handle HOLD Switch Yes No
Add NG — — Touch Operation Setting Yes No
Add KEEP — — Rec Review Setting Yes No
Delete Clip Flag - - Zoom Zoom Type Yes No
Lock/Unlock Clip Select Clip — — Handle Zoom Setting Yes No
Lock All Clips — — High Yes No
Unlock All Clips — — Low Yes No
Delete Clip Select Clip - - Menu Settings User Menu Only Yes No
All Clips - - User Menu with Lock No No
Transfer Clip Select Clip - - Menu Page On/Off  Main Yes No
All Clips - - Camera Yes No
Transfer Clip (Proxy)  Select Clip — — Audio Yes No
All Clips - - Project Yes No
Filter Clips OK - - Monitoring Yes No
NG - - Assignable Button Yes No
KEEP - - Battery Yes No
None - - Media Yes No
All - - Network Yes No
Customize View Thumbnail Caption Yes — File Transfer Yes No
Fan Control Setting Yes No
Lens Zoom Ring Direction Yes No
Shading Compensation Yes No
Chroma Aberration Comp. Yes No
Distortion Comp. Yes No
Breathing Compensation Yes No
Distance Display Yes No
Zoom Position Display Yes No
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LEVEL 1 LEVEL 2 LEVEL 3 All File  Scene LEVEL1 LEVEL 2 LEVEL 3 All File  Scene
File File
Technical Video Light Set Video Light Set Yes No Network ST Mode Settings Camera Remote Control Yes No
APR APR — — Connected Network
Camera Battery Alarm Low Battery Yes No SSID — —
Battery Empty Yes No Security — —
Camera DCIN Alarm  DC Low Voltagel Yes No Password — —
DC Low Voltage2 Yes No DHCP — —
Network Access User Name No No IP Address — —
Authentication Input Password No No Subnet Mask — —
Generate Password — — Gateway — —
Show Settings — — DNS Auto — —
Wireless LAN Setting Yes No Primary DNS Server — —
WPS — — Secondary DNS Server — —
NFC — — Scan Networks
MAC Address — — SSID — —
AP Mode Settings Channel Yes No Security — —
Camera SSID & Password — — Password No No
Regenerate Password — — DHCP Yes No
IP Address — — IP Address Yes No
Subnet Mask — — Subnet Mask Yes No
Gateway Yes No
DNS Auto Yes No
Primary DNS Server Yes No
Secondary DNS Server Yes No
Manual Register
SSID Yes No
Security Yes No
Password No No
DHCP Yes No
IP Address Yes No
Subnet Mask Yes No
Gateway Yes No
DNS Auto Yes No
Primary DNS Server Yes No
Secondary DNS Server Yes No
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LEVEL 1 LEVEL 2 LEVEL 3 All File  Scene LEVEL1 LEVEL 2 LEVEL 3 All File  Scene
File File
Network Wired LAN Setting Yes No Maintenance Language Select Yes No
Camera Remote Control Yes No Clock Set Time Zone Yes No
Detail Settings Date Mode Yes No
DHCP Yes No 12h/24h Yes No
IP Address Yes No Date No No
Subnet Mask Yes No Time No No
Gateway Yes No All Reset Reset — —
DNS Auto Yes No Reset without Network — —
Primary DNS Server Yes No Hours Meter Hours(System) — —
Secondary DNS Server Yes No Hours(Reset) — —
Modem Setting Yes No Reset — —
Camera Remote Control Yes No Version Version Number — —
Device Name — — Version Up — —
IP Address — — Lens Version Number — —
Subnet Mask — —
File Transfer Auto Upload (Proxy) Yes No
Default Upload Server Yes No

Clear Completed Jobs

Clear All Jobs — —

View Job List — —

Server Settings1/Server Settings2/Server Settings3
Display Name Yes No
Service Yes No
Host Name Yes No
Port Yes No
User Name No No
Password No No
Passive Mode Yes No
Destination Directory Yes No
Using Secure Protocol Yes No

Root Certificate

Root Certificate Status

Reset

Network Reset

Reset
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PHAFTILHRI U IC LB TEIEB

Yes : J7AIIREINET
No: 77AIICRETNE LA
—  IPANEREINECA(—BFMEEA Z21—)

T YA FTILIRG > DEIRFE All File Scene File
ND Filter Position Yes No

Auto Iris Yes No

ATW Yes No

Focus Setting Yes No
Display Yes —

VF Adjust Yes —
PHAFTILIAVILIC LB EER
Yes: 77AIILICREFESNET

No: 77AILICREINE A
— IR EINEBA(—BMBEIEAZ21—)

FHAFTILILVILDFEIRE All File Scene File
IRIS Yes No

ND Filter Yes No

Audio Input Level Yes No
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Audio Input (CH3&CH4)
NYRILEEROTOYIIAVYISLTY,

[1kHz Tone on Color

[Color Bars]

0~99

[CH3 Input Level]

(.
[CH3 Level]

Level+CH3 Input Level

Audio Input Level
Through

CH3 Input Level

]
U

7

[CH3 Level
Control]*
Auto
Manual

\

Mono
Stereo

[Limiter Mode]
Off, -6dB,

xl
——————

[Audio Input Level]

0~99

[CH4 Input Level]

Level+CH4 Input Level

CH4 Input Level
Through

Audio Input Level

[CH4 Level]

[CH4 Level
Control]*
Auto
Manual

[CH3 Wind Filter]

[CH3 Input Select]
Internal MIC

INPUT1
Shoe CH1

OFF

INPUT1
INPUT2
Internal MIC

Shoe CH1

Shoe CH2

[CH4 Input Select]
Internal MIC

INPUT2
Shoe CH2

0~99

-9dB, -12dB,
-15dB, -17dB

BTYUET,

r

* XLR74 F9—-h5sDBEBEAANS 2L EEManuall



136  8& IR :7OvI5A4VIILA

Audio Output

CH1 o N
CH2 >
SDI OUT
CH3 >
CH4 I T y > <
8\¢\¢ ( )
I HDMI OUT
Y ] "\ J

N /

[HDMI Output CH]
CH1/CH2, CH3/CH4

v

Internal Speaker

Headphone

CH1, CH2, CH3, CH4,
CH1/CH2, CH3/CH4,
MIX ALL

]
1
1
1
1
\

[Alarm Level] [VOLUME]
0~7 0~50
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MPEG-4 AVC Patent
Portfolio LicenselcDWT

AERIE. MPEG LA, LLCAS 1t 5EE %
fToTWBAVC PATENT PORTFOLIO LICENSE
DT ROBRICBRYSAEVRAINTVET:
(i) HBEEHNBANZ L IMMORMEZ T TV
WERBE®NT. MPEG-4 AVCERRICAEL
EFZFES AT, AVCVIDEOEVLWWET)
CI>a—-R¥3zE,

(ii)AVC VIDEOGHE & HMEA M E Tz (2t DR
AZIFTTOWEVWERNTIYO-RLEL D,
EHLLIIMPEG LAKYS A2 #2EB L
FONAS—HNI>I-RLEHDICESNE
) EFTI-RF32E,

BHE. ZOMORARICEALTIIZIEYIENT
WEtHA, 7O0E—>3a>, BENCFATSS
CICEATREMAERICDOETELTIE. MPEG

LA, LLC.OR—LR—JHZSRBIET W,

GPL/LGPLERY 7 kD7
DAFICDWVT

AERIEGPL/LGPLERDOY 7oz 7% ER
LTHY. BERICIE. cNSOYTRIIT7D
V—2I—ROAF. WZE. BERADEFHHS
ZEEBHRSELET,

b (YONESY Su B NS @2 B S N Ly S e
hodo>0-RFZZENTAEETT. UTO
URLIZZZ AT NIE. EAFRMGSTI>O-RD
HENDMB LSO TVET.,

https://0ss.sony.net/Products/Linux/

BH. V-AOA—ROFHICDODVWTOSEVED
BRTEELIETW,

SAEYZRBEN) [CEALTIE. AHEOREA
EY—-AIEERINTVET,
AigE/XVIAVEIZ RN — TR L.
TPMHOME; - TLICENSEIRICH 2T 7 (L%
—B<KIET W,

Mack ZEROZE I, AHDOTPMHOME! -
TLICENSEJ IZPU ERTERVWZ ENHBYWET,
T7 I EFGEIEMacA s EBFEVLWETE<
M. FEURLIZP7ERLT I 7ML EZBIRL
ZEW,
https://oss.sony.net/License/ILME-FX6/

END USER LICENSE
AGREEMENT

IMPORTANT:

BEFORE USING THE SOFTWARE CONTAINED IN THE
SOLID STATE MEMORY CAMCORDER, PLEASE READ THIS
END USER LICENSE AGREEMENT ("EULA") CAREFULLY. BY
USING THE SOFTWARE YOU ARE ACCEPTING THE TERMS
OF THIS EULA. IF YOU DO NOT ACCEPT THE TERMS OF
THIS EULA, YOU MAY NOT USE THE SOFTWARE.

This EULA is a legal agreement between you and Sony
Corporation ("SONY”). This EULA governs your rights
and obligations regarding the software of SONY and/or
its third party licensors (including SONY's affiliates) and
their respective affiliates (collectively, the “THIRD-PARTY
SUPPLIERS") contained in the wireless adapter, together
with any updates/ upgrades provided by SONY, any
printed, on-line or other electronic documentation for

such software, and any data files created by operation of
such software (collectively, the “SOFTWARE").

Notwithstanding the foregoing, any software in

the SOFTWARE having a separate end user license
agreement (including, but not limited to, GNU General
Public license and Lesser/Library General Public License)
shall be covered by such applicable separate end user
license agreement in lieu of the terms of this EULA to
the extent required by such separate end user license
agreement (“EXCLUDED SOFTWARE").

SOFTWARE LICENSE

The SOFTWARE is licensed, not sold. The SOFTWARE is
protected by copyright and other intellectual property
laws and international treaties.

COPYRIGHT

All right and title in and to the SOFTWARE (including,
but not limited to, any images, photographs, animation,
video, audio, music, text and “applets” incorporated into
the SOFTWARE) is owned by SONY or one or more of the
THIRD-PARTY SUPPLIERS.

GRANT OF LICENSE

SONY grants you a limited license to use the SOFTWARE
solely in connection with the wireless adapter and only
for your individual use. SONY and the THIRD-PARTY
SUPPLIERS expressly reserve all rights, title and interest
(including, but not limited to, all intellectual property
rights) in and to the SOFTWARE that this EULA does not
specifically grant to you.

REQUIREMENTS AND LIMITATIONS

You may not copy, publish, adapt, redistribute, attempt to
derive source code, modify, reverse engineer, decompile,
or disassemble any of the SOFTWARE, whether in whole
orin part, or create any derivative works from or of the
SOFTWARE unless such derivative works are intentionally
facilitated by the SOFTWARE. You may not modify or
tamper with any digital rights management functionality
of the SOFTWARE. You may not bypass, modify, defeat
or circumvent any of the functions or protections of the
SOFTWARE or any mechanisms operatively linked to

the SOFTWARE. You may not separate any individual
component of the SOFTWARE for use on more than one
wireless adapter unless expressly authorized to do so

by SONY. You may not remove, alter, cover or deface

any trademarks or notices on the SOFTWARE. You may
not share, distribute, rent, lease, sublicense, assign,
transfer or sell the SOFTWARE. The software, network
services or other products other than SOFTWARE upon
which the SOFTWARE'S performance depends might

be interrupted or discontinued at the discretion of

the suppliers (software suppliers, service suppliers, or
SONY). SONY and such suppliers do not warrant that the
SOFTWARE, network services, contents or other products
will continue to be available, or will operate without
interruption or modification.

EXCLUDED SOFTWARE AND OPEN SOURCE
COMPONENTS

Notwithstanding the foregoing limited license grant,
you acknowledge that the SOFTWARE may include
EXCLUDED SOFTWARE. Certain EXCLUDED SOFTWARE
may be covered by open source software licenses
("Open Source Components”), which means any
software licenses approved as open source licenses by
the Open Source Initiative or any substantially similar
licenses, including but not limited to any license that,
as a condition of distribution of the software licensed
under such license, requires that the distributor make
the software available in source code format. If and to
the extent disclosure is required, please visit www.sony.
com/linux or other SONY-designated web site for a list
of applicable OPEN SOURCE COMPONENTS included in
the SOFTWARE from time to time, and the applicable
terms and conditions governing its use. Such terms
and conditions may be changed by the applicable
third party at any time without liability to you. To the
extent required by the licenses covering EXCLUDED
SOFTWARE, the terms of such licenses will apply in lieu
of the terms of this EULA. To the extent the terms of the
licenses applicable to EXCLUDED SOFTWARE prohibit
any of the restrictions in this EULA with respect to such
EXCLUDED SOFTWARE, such restrictions will not apply
to such EXCLUDED SOFTWARE. To the extent the terms
of the licenses applicable to Open Source Components
require SONY to make an offer to provide source code
in connection with the SOFTWARE, such offer is hereby
made.


https://oss.sony.net/Products/Linux/
https://oss.sony.net/License/ILME-FX6/
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USE OF SOFTWARE WITH COPYRIGHTED
MATERIALS

The SOFTWARE may be capable of being used by you

to view, store, process and/or use content created by
you and/or third parties. Such content may be protected
by copyright, other intellectual property laws, and/

or agreements. You agree to use the SOFTWARE only

in compliance with all such laws and agreements that
apply to such content. You acknowledge and agree

that SONY may take appropriate measures to protect
the copyright of content stored, processed or used by
the SOFTWARE. Such measures include, but are not
limited to, counting the frequency of your backup and
restoration through certain SOFTWARE features, refusal
to accept your request to enable restoration of data, and
termination of this EULA in the event of your illegitimate
use of the SOFTWARE.

CONTENT SERVICE

PLEASE ALSO NOTE THAT THE SOFTWARE MAY BE
DESIGNED TO BE USED WITH CONTENT AVAILABLE
THROUGH ONE OR MORE CONTENT SERVICES (“CONTENT
SERVICE"). USE OF THE SERVICE AND THAT CONTENT IS
SUBJECT TO THE TERMS OF SERVICE OF THAT CONTENT
SERVICE. IF YOU DECLINE TO ACCEPT THOSE TERMS,
YOUR USE OF THE SOFTWARE WILL BE LIMITED. You
acknowledge and agree that certain content and
services available through the SOFTWARE may be
provided by third parties over which SONY has no
control. USE OF THE CONTENT SERVICE REQUIRES AN
INTERNET CONNECTION. THE CONTENT SERVICE MAY BE
DISCONTINUED AT ANY TIME.

INTERNET CONNECTIVITY AND THIRD PARTY
SERVICES

You acknowledge and agree that access to certain
SOFTWARE features may require an Internet connection
for which you are solely responsible. Further, you are
solely responsible for payment of any third party fees
associated with your Internet connection, including

but not limited to Internet service provider or airtime
charges. Operation of the SOFTWARE may be limited

or restricted depending on the capabilities, bandwidth
or technical limitations of your Internet connection

and service. The provision, quality and security of such
Internet connectivity are the sole responsibility of the
third party providing such service.

EXPORT AND OTHER REGULATIONS

You agree to comply with all applicable export and re-
export restrictions and regulations of the area or country
in which you reside, and not to transfer, or authorize

the transfer, of the SOFTWARE to a prohibited country
or otherwise in violation of any such restrictions or
regulations.

HIGH RISK ACTIVITIES

The SOFTWARE is not fault-tolerant and is not designed,
manufactured or intended for use or resale as on-line
control equipment in hazardous environments requiring
fail-safe performance, such as in the operation of nuclear
facilities, aircraft navigation or communication systems,
air traffic control, direct life support machines, or
weapons systems, in which the failure of the SOFTWARE
could lead to death, personal injury, or severe physical or
environmental damage (“HIGH RISK ACTIVITIES"). SONY,
each of the THIRD-PARTY SUPPLIERS, and each of their
respective affiliates specifically disclaim any express or
implied warranty, duty or condition of fitness for HIGH
RISK ACTIVITIES.

EXCLUSION OF WARRANTY ON SOFTWARE
You acknowledge and agree that use of the SOFTWARE
is at your sole risk and that you are responsible for use
of the SOFTWARE. The SOFTWARE is provided “AS IS,”
without warranty, duty or condition of any kind.

SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as
“SONY") EXPRESSLY DISCLAIM ALL WARRANTIES, DUTIES
OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING,

BUT NOT LIMITED TO, THE IMPLIED WARRANTIES

OF MERCHANTABILITY, NONINFRINGEMENT AND
FITNESS FOR A PARTICULAR PURPOSE. SONY

DOES NOT WARRANT OR MAKE ANY CONDITIONS

OR REPRESENTATIONS (A) THAT THE FUNCTIONS
CONTAINED IN ANY OF THE SOFTWARE WILL MEET YOUR
REQUIREMENTS OR THAT THEY WILL BE UPDATED, (B)
THAT THE OPERATION OF ANY OF THE SOFTWARE WILL
BE CORRECT OR ERROR-FREE OR THAT ANY DEFECTS
WILL BE CORRECTED, (C) THAT THE SOFTWARE WILL

NOT DAMAGE ANY OTHER SOFTWARE, HARDWARE OR
DATA, (D) THAT ANY SOFTWARE, NETWORK SERVICES
(INCLUDING THE INTERNET) OR PRODUCTS (OTHER

THAN THE SOFTWARE) UPON WHICH THE SOFTWARE'S
PERFORMANCE DEPENDS WILL CONTINUE TO BE
AVAILABLE, UNINTERRUPTED OR UNMODIFIED, AND
(E) REGARDING THE USE OR THE RESULTS OF THE USE
OF THE SOFTWARE IN TERMS OF ITS CORRECTNESS,
ACCURACY, RELIABILITY, OR OTHERWISE.

NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN
BY SONY OR AN AUTHORIZED REPRESENTATIVE OF SONY
SHALL CREATE A WARRANTY, DUTY OR CONDITION OR
IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY.
SHOULD THE SOFTWARE PROVE DEFECTIVE YOU ASSUME
THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR
OR CORRECTION. SOME JURISDICTIONS DO NOT ALLOW
THE EXCLUSION OF IMPLIED WARRANTIES, SO THESE
EXCLUSIONS MAY NOT APPLY TO YOU.

LIMITATION OF LIABILITY

SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as
“SONY") SHALL NOT BE LIABLE FOR ANY INCIDENTAL

OR CONSEQUENTIAL DAMAGES FOR BREACH OF ANY
EXPRESS OR IMPLIED WARRANTY, BREACH OF CONTRACT,
NEGLIGENCE, STRICT LIABILITY OR UNDER ANY OTHER
LEGAL THEORY RELATED TO THE SOFTWARE, INCLUDING,
BUT NOT LIMITED TO, ANY DAMAGES ARISING OUT OF
LOSS OF PROFITS, LOSS OF REVENUE, LOSS OF DATA,
LOSS OF USE OF THE SOFTWARE OR ANY ASSOCIATED
HARDWARE, DOWN TIME AND USER'S TIME, EVEN IF ANY
OF THEM HAVE BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. IN ANY CASE, EACH AND ALL OF THEIR
AGGREGATE LIABILITY UNDER ANY PROVISION OF THIS
EULA SHALL BE LIMITED TO THE AMOUNT ACTUALLY
PAID FOR THE PRODUCT. SOME JURISDICTIONS DO NOT
ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL
OR CONSEQUENTIAL DAMAGES, SO THE ABOVE
EXCLUSION OR LIMITATION MAY NOT APPLY TO YOU.

CONSENT TO USE OF NON-PERSONAL
INFORMATION, LOCATION DATA, DATA
SECURITY

You acknowledge and agree that SONY and its affiliates,
partners and agents may read, collect, transfer, process
and store certain information collected from the
SOFTWARE, including but not limited to information
about (i) the SOFTWARE and (ii) the software

applications, contents and peripheral devices that
interact with your wireless adapter and the SOFTWARE
("Information”). Information includes, but is not limited
to: (1) unique identifiers relating to your wireless adapter
and its components; (2) performance of the wireless
adapter, the SOFTWARE and their components; (3)
configurations of your wireless adapter, the SOFTWARE
and the software applications, contents and peripheral
devices that interact with the wireless adapter and the
SOFTWARE; (4) use and frequency of use of the functions
of (x) the SOFTWARE, and (y) the software applications,
contents and peripheral devices that interact with the
SOFTWARE; and (5) location data, as indicated below.
SONY and its affiliates, partners and agents may use
and disclose Information subject to applicable laws in
order to improve its products and services or to provide
products or services to you. Such uses include, but are
not limited to: (a) administering the functionalities

of the SOFTWARE; (b) to improve, service, update or
upgrade the SOFTWARE; (c) improving, developing and
enhancing the current and future products and services
of SONY and other parties; (d) to provide you with
information about the products and services offered by
SONY and other parties; (e) complying with applicable
laws or regulations; and (f) to the extent offered,
providing you with location-based services of SONY
and other parties, as indicated below. In addition, SONY
retains the right to use Information to protect itself and
third parties from illegal, criminal or harmful conduct.

Certain services available through the SOFTWARE may
rely upon location information, including, but not limited
to, the geographic location of the wireless adapter. You
acknowledge that for the purpose of providing such
services, SONY, the THIRDPARTY SUPPLIERS or their
partners may collect, archive, process and use such
location data, and that such services are governed by the
privacy policies of SONY or such third party. By reviewed
the privacy policies applicable to such services and
consent to such activities.

SONY, its affiliates, partners and agents will not
intentionally use Information to personally identify the
owner or user of the SOFTWARE without your knowledge
or consent. Any use of Information will be in accordance
with the privacy policies of SONY or such third party.
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Please contact applicable contact address of each area or
country for SONY's current privacy policy. Please contact
applicable third parties for privacy policies relating

to personally identifiable and other information you
provide when you use or access third party software or
services.

Information may be processed, stored or transferred

to SONY, its affiliates or agents which are located in
countries outside of your country of residence. Data
protection and information privacy laws in certain
countries may not offer the same level of protection

as your country of residence and you may have fewer
legal rights in relation to Information processed and
stored in, or transferred to, such countries. SONY will
use reasonable efforts to take appropriate technical and
organizational steps to prevent unauthorized access to
or disclosure of Information, but does not warrant it will
eliminate all risk of misuse of such Information.

AUTOMATIC UPDATE FEATURE

From time to time, SONY or the THIRD-PARTY SUPPLIERS
may automatically update or otherwise modify the
SOFTWARE, including, but not limited to, for purposes
of enhancement of security functions, error correction
and improvement of functions, at such time as you
interact with SONY's or third parties’ servers, or
otherwise. Such updates or modifications may delete
or change the nature of features or other aspects of the
SOFTWARE, including, but not limited to, functions you
may rely upon. You acknowledge and agree that such
activities may occur at SONY's sole discretion and that
SONY may condition continued use of the SOFTWARE
upon your complete installation or acceptance of such
update or modifications. Any updates/modifications
shall be deemed to be, and shall constitute part of, the
SOFTWARE for purposes of this EULA. By acceptance of
this EULA, you consent to such update/maodification.

ENTIRE AGREEMENT, WAIVER, SEVERABILITY
This EULA and SONY's privacy policy, each as amended
and modified from time to time, together constitute the
entire agreement between you and SONY with respect
to the SOFTWARE. The failure of SONY to exercise or
enforce any right or provision of this EULA shall not
constitute a waiver of such right or provision. If any part
of this EULA is held invalid, illegal, or unenforceable,

that provision shall be enforced to the maximum extent
permissible so as to maintain the intent of this EULA,
and the other parts will remain in full force and effect.

GOVERNING LAW AND JURISDICTION

The United Nations Convention on Contracts for the
International Sale of Goods shall not apply to this EULA.
This EULA shall be governed by the laws of Japan,
without regards to conflict of laws provisions. Any
dispute arising out of this EULA shall be subject to the
exclusive venue of the Tokyo District Court in Japan, and
the parties hereby consent to the venue and jurisdiction
of such courts.

EQUITABLE REMEDIES

Notwithstanding anything contained in this EULA to the
contrary, you acknowledge and agree that any violation
of or noncompliance with this EULA by you will cause
irreparable harm to SONY, for which monetary damages
would be inadequate, and you consent to SONY
obtaining any injunctive or equitable relief that SONY
deems necessary or appropriate in such circumstances.
SONY may also take any legal and technical remedies
to prevent violation of and/or to enforce this EULA,
including, but not limited to, immediate termination of
your use of the SOFTWARE, if SONY believes in its sole
discretion that you are violating or intend to violate

this EULA. These remedies are in addition to any other
remedies SONY may have at law, in equity or under
contract.

TERMINATION

Without prejudice to any of its other rights, SONY may
terminate this EULA if you fail to comply with any of its
terms. In case of such termination, you must: (i) cease
all use, and destroy any copies, of the SOFTWARE; (ii)
comply with the requirements in the section below
entitled “Your Account Responsibilities”.

AMENDMENT

SONY RESERVES THE RIGHT TO AMEND ANY OF THE
TERMS OF THIS EULA AT ITS SOLE DISCRETION BY
POSTING NOTICE ON A SONY DESIGNATED WEB SITE, BY
EMAIL NOTIFICATION TO AN EMAIL ADDRESS PROVIDED
BY YOU, BY PROVIDING NOTICE AS PART OF THE
PROCESS IN WHICH YOU OBTAIN UPGRADES/ UPDATES
OR BY ANY OTHER LEGALLY RECOGNIZABLE FORM OF

NOTICE. If you do not agree to the amendment, you
should promptly contact SONY for instructions. Your
continued use of the SOFTWARE after the effective date
of any such notice shall be deemed your agreement to
be bound by such amendment.

THIRD-PARTY BENEFICIARIES

Each THIRD-PARTY SUPPLIER is an express intended
thirdparty beneficiary of, and shall have the right to
enforce, each provision of this EULA with respect to the
SOFTWARE of such party.

Should you have any questions concerning this EULA,
you may contact SONY by writing to SONY at applicable
contact address of each area or country.

Copyright © 2012 Sony Corporation.
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